
The Main Screen
Click on an area of the picture below to explain its function

What you can't see on this picture is the edit window.



Comms Setup Window
Click on an area of the window to find out what it does. The picture will scroll if needed. Please note 
that the sixth comms speed option - 38400 - can be toggled between 38400 and 57600 by right clicking 
on that button.



The Script Status Window

This window is displayed when a script is playing, it shows the name of the script and the command 
that is currently being processed.

There is also a cancel button available in case the script gets stuck.



Pressing this button allows you to print the contents of one of the WinPack    text windows. For more 
information see Printing from WinPack.



Pressing this button allows you to select a file and send it to the TNC. It works like selecting the 'Send' 
option on the 'Files' menu. Please note that this option should only be used for text files.



Pressing this button allows you to open a capture file. All received text will be stored in the file until you 
close it by pressing the button again. Capture files will normally be kept in the CAPTURE subdirectory. 
This button has the same effect to selecting 'Capture' from the 'Files' submenu. When capture is off the 
button will have a cross on it.



Pressing this button opens an edit window in the bottom half of the screen. It has the same effect to 
selecting 'Edit' on the 'Files' submenu. There is an    edit submenu which can be accessed from the edit 
window by pressing the right mouse button. Pressing the button when the edit window is already open 
hides the window. When the edit window is closed the button will have a cross on it.
If you hide the edit window whilst you are composing a message, the message is not abandonned. You 
remain in "composing mail" mode until you unhide the window and either Send or Abandon the 
message. To remind you that the edit is still effectively active, the image on the edit button is shown 
with a red box drawn round it.



Received text is displayed in this window. The window can be either a large single window or it can be 
split into two smaller windows. If it is split then the Window Button allows you to select one of the two 
windows. For more information select receive windows.



Single lines of text can be keyed into the transmit window. When you press <Return> the text is sent to 
the TNC. The up and down cursor keys will allow you to scroll through your last 8 commands. <Esc> 
will clear the line. If you key in more characters than the line length specified on the setup screen, the 
program will automatically insert a <Return> and start a new line. This is done in an intelligent way by 
looking for a gap between words.

See also using short cut keys.



The status line shows information about the current state of the terminal. It lets you see whether 
capture is on    and also how much of the transmit buffer is currently being used. Although not shown on 
this picture, if you are connected to another station, the callsign of the connected station will be shown.

The status of the TNC RS232 status lines and whether you are currently connected is also shown. If 
capture is on then the name of the current capture file will be shown. The transmit buffer figure is a 
'health check' and, unless you are sending a file, it should always read '0', since the program buffer only 
starts to fill when the TNC's own buffer is full.



Receive Windows
First of all, you don't have to use a split receive window! Regard it as an advanced option - if you are 
happy with a single window then simply ignore it. (The idea of having two receive windows was put in 
before the program had proper support for reading bulletins. It was so you could connect to your local 
BBS, list the bulls in one window and read them in the other.)

All incoming text goes into the receive Window. This can be configured as a single window or as two 
smaller windows. (You use the 'Split Window' option on the 'Options' submenu to do this).

If it is split then the incoming text only goes into one of the two windows at any one time. The idea of 
this is that you can list the messages on your local BBS into one window and then read them in the 
other. This stops the message list being scrolled away as you read the messages.

In fact, when you have listed the messages into one window, simply double clicking a message number 
will send a 'read' command for that message to the BBS, and it will be received into the other window.

The sizes of the two windows can be adjusted as follows - Put the mouse cursor on the separator bar 
between the two windows and it will turn into a horizontal bar. You can then drag the bar up and down.



The Files Menu
Edit Window
Selecting this opens an edit window in the bottom half of the screen. It has the same effect to pressing 
the edit button. There is an    edit submenu which can be accessed from the edit window by pressing 
the right mouse button. Selecting this option when the edit window is already open hides the window.

If you hide the edit window whilst you are composing a message, the message is not abandoned. You 
remain in "composing mail" mode until you unhide the window and either Send or Abandon the 
message. To remind you that the edit is still effectively active, the image on the edit button is shown 
with a red box drawn round it.

Capture
Selecting this option allows you to open a capture file. All received text will be stored in the file until you 
close it by selecting the option again. Capture files will normally be kept in the CAPTURE subdirectory. 
This option has the same effect as pressing the capture button.

Send
This option allows you to select a file, which will then be sent to the TNC. Please note that this option 
should only be used for text files. See also Using Drag and Drop.

Delete
This option allows you to delete files. When you have selected a file to delete, you will be prompted for 
confirmation before it is deleted. You can delete multiple files by clicking one file name and then holding 
the shift key down and clicking other file names.

Print
Selecting this menu option allows you to print the contents of one of the WinPack    text windows. For 
more information see Printing from WinPack.

Exit
This option allows you to exit from the packet terminal.

Besides the above options, this menu may also display some WinPack "Extra" options. These will come 
between "Print and "Exit". For more information see WinPack Extras.



If the receive window is split then this Window Button allows you to swap between the two windows. If it 
shows '1' the the upper window is selected, '2' means that the lower window is selected. For more 
information select receive windows.

If you are using WinPack in BPQ mode, this button is replaced by one that allows you to start the BPQ 
Terminal program.



Selecting this option alternately enables and disables the program's 'bell'. The bell can be useful if you 
are connected to the DX Cluster, since the default is that the Cluster will send a 'bell' with every 'spot'. 
When the bell is disabled the option does not have a tick against itt. This option has the same effect to 
pressing the 'bell' button.



This option allows you to split the receive screen into two windows. If you select it while the screen is 
already split then the single large receive window will be restored. For more information select receive 
windows.

Ctrl+S is a shortcut to this menu option.



This submenu has options for changing the font and text colour in the various windows.



This option allows you to setup up the terminal so that it works correctly with your TNC. For more 
information select comms setup window.



This option allows you to set the font size and text foreground colour for the edit window. The text 
background colour is always whatever you have set for Window Background colour in the Windows 
Control Panel 'Color' utility. When choosing a font please bear in mind the following :-
Most Windows fonts are proportionately spaced, also most Windows fonts cannot display the IBM 
graphics characters that are frequently used in packet messages. From version 5 onwards, WinPack 
only makes available fixed pitch fonts. It also will not allow Windows to 'fake' a font style that doesn't 
really exist. These changes were introduced in an effort to stop complaints from users who were 
making their own problems by choosing crazy fonts!
The default font for all the text windows is WinPack 11 point. You may prefer one of the other sizes. The 
12 point is an exact replica of a DOS VGA font. If you have problems with the WinPack font, try 
Terminal.



How Scripts Work
WinPack supports a simple form of script. A script is a series of commands that the program can 
process. It makes it easy for you to automate such functions as connecting to your local BBS, 
downloading the message list, etc.

Scripts are created by using a text editor. You can create them in the edit window and then save them 
in the SCRIPTS subdirectory. Three sample scripts, DXCLUST, BBS and SETTIME are provided with 
the program. If you want to try using scripts please read the comments in these two examples.

There are three special scripts - STARTUP, EXIT and BBSBYE. If these script files exist in your 
SCRIPTS subdirectory then STARTUP will be executed whenever you start the program and EXIT will 
be executed when you quit the program. (The SETTIME script is actually the script that I use as my 
startup script).

BBSBYE, if it exists, is executed when WinPack disconnects at the end of an Auto BBS Session. It can 
be used to drop you off a TheNet style node, after disconnection from the BBS (see comment below 
about EXIT_IF_DIS). It can also be used to run external programs that process mail after a BBS 
session (see the PROC keyword).

Each line of text in a script consists of a key word and then optionally some text that is used as part of 
the command.    Lines in a script starting with a ';' are ignored. Lines that the script interpreter can't 
understand are also ignored!

WAITFOR and WAITLINE are very similar, but NOT the same. WAITFOR constantly scans for the 
specified text being received, it doesn't wait for the end of a line. WAITLINE waits until a line of text has 
been received (a line ends when a <return> character is received) and then scans it for the specified 
text. WAITFOR can normally be used.

WAITLINE was specifically introduced to allow scripts to process FBB sysop passwords. FBB sends an 
identifiable prompt    followed by the password numbers. E.g. "GB7OPC-0> 23 45 32 78 57". Therefore 
you have to look for the prompt, but you cannot move on to the next stage of the script and process the 
password information until the whole line has been received. "WAITLINE GB7OPC-0>" allows you to do 
this.

The following is a list of all the key words are understood by the script interpreter:-

CLOSECAPTURE
Close a capture file.

EXIT_IF_CON
Exit from the script if there is a connection.

EXIT_IF_DIS
Exit from the script if there is no connection. Designed to be used in the BBSBYE script when using that 
script to drop you off a TheNet node after disconnecting from the BBS:-

;give up if we're already disconnected
EXIT_IF_DIS
;wait for the node message
WAITLINE Reconnected to BOST72
;disconnect from the node
SEND b

FBBSYNC



Sends a sync request to the local BBS if you are using the unproto list. See enhanced mail facilities.

HOTKEY <key>
This assigns a hot key to a script. Valid values for <key> are F2 to F9. The script can then be played by 
simply pressing this key.

OPENCAPTURE <filename>
Open a capture file.

PROC <program_name>
Occasionally people want to run a program from a script that does something like processing mail. At 
the time the program runs, there might not be a connection, so RUN cannot be used. PROC can be 
used in these circumstances. It works exactly like RUN except that the status returned by the program 
is ignored, and any output is sent to the WinPack screen.

PLAYTUNE <tune_name>
The .WAV or .MID (MIDI) file <tune_name> is played. The file must be in the WinPack WAV 
subdirectory. WinPack looks for a .WAV file first, if there isn't one it looks for a .MID file. E.g. 
"PLAYTUNE TALK" will play the file TALK.WAV or TALK.MID in the WAV subdirectory.

PLAYWAV <tune_name>
Exactly the same as PLAYTUNE. The command is retained for compatibility with older versions of 
WinPack.

RECONNECT
If a disconnection occurs, the script will rerun - see below.

RUN <program_name>
Run a program. The program must conform to the standard WinPack external program format and be in 
the SCRIPTS\PROGRAMS subdirectory. This facility is designed mainly for dealing with password 
schemes. PLEASE NOTE that RUN will only work if you are connected. External programs are 
designed to either send their output to the TNC if they were started by an external user or by a script, or 
to the screen if the external command was input by the sysop. Therefore an external program can only 
be run from a script if there is a connection. There are some situations when this is too restrictive, and 
so the PROC keyword was introduced:-

SEND <text>
Send <text> to the TNC.

SENDPASSWORD
Sends a password. Normally based on the previous line of text.    See Password Support.

STAY_CONNECTED
This key word is only relevant to the BBS.TXT script. It tells WinPack to stay connected to the BSS at 
the end of Auto BBS sessions. However, if the session uses FBB compressed forwarding, then 
STAY_CONNECTED will be ignored, because FBB will not accept normal BBS user commands after 
compressed forwarding protocol has been used. Note that using this key word will mean that WinPack 
always stays connected to the BBS at the end of an Auto BBS session, if you only occasionally want to 
stay connected, then the "Stay Connected" option on the "Action" menu is available.

SUSPENDREMOTE



Most WinPack users will want to have "Enable Remote" on the Options menu checked, so that people 
who connect to their system can use the Remote Access Commands. This can occasionally cause a 
problem if another system you connect to sends what looks to WinPack like a remote command, when 
in fact it isn't. The common example is that, if you connect to a JNOS converse server it has a line that 
starts "/bye" as part of its help - if WinPack sees that and "Enable Remote" is checked, then it 
disconnects!

If you use SUSPENDREMOTE in a script then it will TEMPORARILY disable the remote commands, it 
is reset when a disconnection occurs. An example script using it might be:-

C SLCHAT
WAITCON
SUSPENDREMOTE

NOTE - you must WAITCON before you SUSPENDREMOTE, the command is ignored if you aren't 
connected.

TITLE <text>
If you put a title line in a script, then, when you use the "Play A Script" menu option, the list displayed 
will contain the title rather than just the file name.

WAITCON
Wait for a connection to be established. The <text> is optional, if used it should consist of words or 
phrases that will be received if the connection attempt fails. You can include several options, separated 
with '|' characters. Please note that it is case sensitive.

Example - you might put "WAITCON retry count exceeded". If, whilst waiting for the connection, a line is 
received containing "retry count exceeded", then the Auto BBS Session will be abandoned.

See also WAITPROMPT below.

WAITDIS
Wait for disconnection.

WAITFOR <text>
Wait for <text> to be received.

WAITLINE <text>
Wait for a line of text, with <text> anywhere in it.

WAITPROMPT <text>
Wait for a line which both contains the text specified in "BBS Prompt" in Personal/BBS Info *and* ends 
with a '>'.    The <text> is optional, if used it should consist of words or phrases that will be received if 
the BBS is not available. You can include several options, separated with '|' characters. Please note that 
it is case sensitive.

Example - you might put "WAITPROMPT Busy from|all ports in use". If, whilst waiting for the BBS 
prompt, a line is received containing either "Busy from" or "all ports in use", then the Auto BBS Session 
will be abandoned.

See also WAITCON above.

Control characters and Tokens



The SEND command will normally put a carriage return on the end of <text>. There aren't many 
situations where you wouldn't want to send a <Return>, so it is pointless always having to specify it. If 
you don't want a <Return> sent then put a '~' character (tilde) on the end of the text. E.g. "SEND *~" will 
send an asterisk without a <Return> after it, which is very handy for auto-bauding AEA TNCs.

If you want to include control characters in SEND commands, you can do it by putting a '^' followed by 
the character.    E.g. to send a Ctrl+G, you would put "^G".

Usually any WAITFOR text will also end with a <Return> because you will normally be waiting for a 
prompt of some sort from the other end. However, there may be times when the text you are waiting for 
doesn't end with a <Return>. Therefore you have to put in the <Return> if it is part of WAITFOR text. 
You do this by putting in '^M'. The '^' is a shifted '6' on a UK keyboard.

Have a look at the sample scripts and it will be obvious what to do.

The script interpreter understands a limited number of tokens, which are described in the tokens list.

Reconnection
If the script contains the keyword RECONNECT, then, when it has successfully completed the following 
will happen:-

1. A button with the caption 'R' will appear on the status bar.

2. If a disconnection occurs the script will be rerun. This will carry on happening until you click the 
button - which makes it disappear.

3. After the first reconnection the caption will change to '1', the next time it will go to '2'. When it reaches 
'9' it goes to 'A' and then carries on through the alphabet. The idea of this is to let you know how 
frequently you are getting disconnected!

The sole purpose of the reconnection facility is to enable you to automatically reconnect to a DX Cluster 
if the link drops out. How successful it is depends on what causes the disconnect - if it is caused by a 
Cluster crash then this instant reconnect will normally fail. The default delay before attempting a 
reconnect is 10 seconds. You may find it better to increase this:-

(a) Make sure WinPack is not running.

(b) Edit PACKET.INI in the WinPack directory using a text editor such as Windows Notepad.

(c) Look for a section entitled [TERMINAL], in that section there is an entry which says 
'RECONNECT_DELAY=10'. Change the 10 (seconds) to a bigger value.

(d) Save the file.



This window shows you the script command that is currently being processed. In this case it is waiting 
for the end of the prompt from a BBS. The '^M' means a <Return> character. For more information see 
scripts - how they work.



This button allows you to cancel a script that is playing.
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PACKET.INI



Select the data bits setting that will be used between your PC and TNC.



Select the stop bits setting that will be used between your PC and TNC.



Select the parity setting that will be used between your PC and TNC.



Select the COM port that you wish to use.



If your TNC uses the DCD line to show the connected state then select 'Yes', if it doesn't then select 
'No'. You will soon find out whether it does or not by watching the DCD indicator on the status bar. It 
should be green when you aren't connected to another station and red when you are. All self-respecting 
TNCs should support DCD!

However, some TNC s seems t o use the DCD the wrong way round, so an extra DCD mode has been 
added which is 'INVERSE'. If this is selected then when the DCD indicator is GREEN WinPack will 
regard the TNC as being connected, and when it is RED it will regard the TNC as being disconnected. 
This was added to help a local station who had a PK12 which definitely worked this way. However, I 
would think that there might well be a ROM update available for the TNC    to fix the problem.



Input the line length to be used in the editor. If any line is longer than this then a <Return> will be 
inserted. In the interests of those who have to read your messages, I have limited the line length to 78 
characters. 
Tip - if you use no more than about 74 characters, it will allow your messages to be 'quoted' without 
them becoming a complete mess.



This is the message that the TNC sends when a connection occurs. It is almost always '*** 
CONNECTED to <callsign>'.

If your TNC doesn't use DCD to show the connected state (any self-respecting TNC should be capable 
of using DCD!) then WinPack tries to monitor the connected state by looking for the TNC sending this 
string. THIS METHOD CAN NEVER BE RELIABLE. To enable it you must also set 'DCD shows con 
state' to 'No'.

This string of characters is also used to work out the callsign of the station to which you are connected, 
so it is important that you input it correctly.



This is the message that the TNC sends when a disconnection occurs. It is almost always '*** 
DISCONNECTED'.

If your TNC doesn't use DCD to show the connected state (any self-respecting TNC should be capable 
of using DCD!) then WinPack tries to monitor for disconnections by looking for the TNC sending this 
string. THIS METHOD CAN NEVER BE RELIABLE. To enable it you must also set 'DCD shows con 
state' to 'No'.



Pressing this button causes the new settings to take effect.



Pressing this button cancels any changes that you have made to the setup.



The Edit Window
When using the edit window for writing mail, for best results, only put a <return> at the end of 
paragraphs. Let the window flow the text for you. When the text is transmitted, WinPack will make sure 
that text lines are no longer than the line length setup in "Options", "Comms Setup". The end result is 
more pleasing to the eye if you have not put a <return> at the end of every line.

The window can be zoomed up to the full size of the WinPack screen by selecting "Zoom" from the pop-
up edit menu, or by pressing Ctrl+Z when the cursor is in the edit window. Using either option again 
returns the window to its normal size.

The top line of the edit window shows a character count for the text being edited - helps you keep within 
the message size guidlines! (This isn't visible in the picture below).

The pop-up edit menu is activated by either pressing F10 when the cursor is in the edit window, or right 
clicking with the mouse (twice for Win95) in the window. You can click on the menu options in the 
picture below to find out what they do.



If you select the send option, the text currently in the window will be sent to the TNC. The idea is so that 
you can easily compose messages in an editor, rather than sending them a line at a time straight to 
your local BBS.

When the text is sent the window is cleared. However, the text is also copied to the Windows clipboard, 
so, if you want to get it back, press Control_V.



This option allows you to save the contents of the window to a file.



This option allows you to load an existing text file into the window. See also Using Drag and Drop.



If you select this option the window is cleared.



Selecting this option will hide the window. However, its contents will be preserved.



Welcome to WinPack!
WinPack provides you with a full-featured Windows interface to use with your TNC.

The main screen is split into two (or more) sections. In its default layout there is a large receive window 
and a single line transmit window at the bottom, which can be replaced by a multi-line edit window.

WinPack has full support for handling personal mail and reading bulletins, including automatic 
connection to your local BBS. It can use the FBB unproto message beacons, compressed download 
and compressed forwarding. It also supports auto 7+ encode and decode.

WinPack will run "on top of" the G8BPQ node software.

WinPack supports script files which can be used to automate such tasks as connecting to your local 
BBS or logging in to the DX Cluster.

WinPack supports both servers and external programs. 

WinPack can be used with a telephone modem to connect to the land-line port of an FBB BBS. See 
phone modem support for more information.

Remember - if you get stuck, read the help! Context sensitive help is always available by pressing 
<F1>.

Getting Started
WinPack, as its name implies, is a Windows program!    It uses many standard 
Windows controls - menus, file dialogues, etc. One thing you must appreciate is that if 
you aren't comfortable with Windows you might at first find the program difficult. If so, 
stick with it, for once you get used to Windows    you'll never go back to DOS!

Don't try to immediately use all the features of the program. To start off with, once you have used the 
setup menu option to configure WinPack to match your TNC, you can use the program as a simple 
terminal and completely ignore most of the features. Try out the more advanced features when you are 
comfortable with the basics.



Normally, text keyed into the transmit window isn't sent to the TNC until <Return> is pressed at the end 
of the line. This is usually the best way to operate. However, there are some circumstances when it is 
necessary to send the characters to the TNC immediately a key is pressed. For example, if you run the 
'CAL' command on a Tiny-2, you need to be able to send the single letters 'K', 'D',    etc. On such 
occasions it is best to switch the program into character mode. 

In character mode the transmit window is not used, so you lose the split screen operation and the 8 
transmit scroll-back buffers. The program normally operates with ECHO OFF and does its own local 
echo of the characters. This does not work very well in character mode and so, when you switch to 
character mode, it sends ECHO ON to the TNC.

If the program is already in character mode, selecting this option will switch it back to normal mode. 
ECHO OFF will be sent to the TNC.



TNC Settings and Connections
It would be impossible to list the optimum settings to use with WinPack for every different type of TNC 
available. However, in the WINPACK\TNCPARAM directory are example settings, for most popular 
TNCs, that are known to work with WinPack. These can be used as a good starting point. Please 
makes sure that you adjust settings such as FRACK, MAXFRAME and PACLEN to suit local conditions.

Some of the TNCPARAM files have comments at the top which give advice specific to that particularly 
TNC, based on the experience of others using it with WinPack. It is always worthwhile to have a look at 
the file relevant to your TNC, even if you are confident that you know how to set it up.

The following general points about TNC settings and connections may be helpful.

Coms Settings
Firstly, make sure that the coms parameters on the setup screen actually match your TNC settings! If 
you set WinPack to 8 data bits, your TNC won't like it if it is set to 7 data bits. If you don't set 8 data bits, 
you can't use Yapp. It simply would not work, so the program stops you even trying.

Initially you must set WinPack to match your TNC settings, otherwise the two won't be able to 
communicate. Once you have got them working together I would recommend these settings:-
9600 baud
8 data bits
no parity
1 stop bit
handshaking RTS/CTS
You will have to read your TNC manual to find out the commands for changing the settings. Some may 
not have obvious names.

If you change the settings, change the TNC first and then RESTART it. Virtually all TNCs don't start 
using new coms settings until they are restarted.

You will probably now be getting garbled text on the screen, so change the settings on the WinPack 
setup screen to match your new TNC settings.

The PC to TNC Cable
If your PC to TNC cable is not made up correctly, you are bound to have problems! A very common 
problem is using a cable which does not connect the DCD line between the TNC and the PC - this 
leads to difficulties with WinPack not recognising when a connection has occurred.

 Your TNC manual should give advice on the correct cable configuration. For most TNCs the following 
RS232 lines should be connected in the cable. The pin out is given for both DB25 and DB9 connectors.
Line DB9 DB25
TX Data     3       2
RX Data     2       3
RTS     7       4
CTS     8       5
DSR     6       6
Sig Gnd     5       7
DCD     1       8
DTR     4  20

8BITCONV ON
You must set 8BITCONV ON. If you don't then you will never have any success with Seven Plus.



BREAK ON
I don't think all TNCs have this parameter, but Tiny 2's certainly do. It is either ON or OFF. The default is 
ON - don't change it!

CMDTIME 1
This is the "guard time" for sending three COMMAND characters to get the TNC out of transparent 
mode. Set CMDTIME 1, or whatever value equates to 1 second with your particular brand of TNC.

CMSG ON
It doesn't need to be ON, but if you put in some CTEXT and then wonder why it doesn't get sent when 
someone connects, it is almost certainly because CMSG is OFF!

COMMAND $03
This is the character that puts the TNC back into command mode when you are connected. The default 
is $03 (control C). If you change it you will probably struggle to get Yapp to work.

CTEXT Welcome to WinPack. Send /h for HELP...
Some packet programs require you to put an SID banner in the CTEXT, e.g. something like [PROG-1.0-
$]. You don't need to do this with WinPack and it isn't recommended because it might trigger another 
system into starting to try to send you mail. So simply make the CTEXT a friendly greeting.

DCDCONN ON (AEA TNCs)
On the PK232, PK96 and probably some other AEA TNCs, you *must* set DCDCONN to ON.

ECHO OFF
ECHO OFF is recommended. If you have ECHO ON, then everything you key in will appear on the 
screen twice!

HEADERLN ON
If you want to use the FBB Unproto List to collect your message list, you must have 'HEADERLN ON'.

MCON OFF
MCON must be OFF.

NEWMODE ON
NEWMODE ON is recommended. If you want to know what it means, read your TNC manual, you 
should then be even more confused!

NOMODE OFF
NOMODE OFF is recommended. Same comment as above!

STREAMDB OFF
"STREAMDB OFF" is recommended because TNCs running TNC2 firmware, or derivatives of it, double 
the streamswitch character even when the TNC is in transparent mode, the only exception being if 
STREAMSW is set to $00. (To me this seems to be incorrect behaviour!).

STREAMSW $00
The stream switch character is the one thing that will definitely foul up 7+ transfers if the normal default 
setting of '|' (pipe character) is used. You will find it impossible to send 7+ files unless this is changed to 
a non-printing character. 'STREAMSW $00' is recommended and should be used unless you have a 



*really* good reason to use something else.

UNPROTO <bbs>
If you want to use the FBB Unproto List to collect your message list, you must set UNPROTO either 
directly to your local BBS callsign (e.g. 'UNPROTO GB7OPC') or to a path via a digipeater that will 
enable your sync requests to be heard by the BBS (e.g. 'UNPROTO GB7OPC VIA STUMP'). This is 
explained in more detail in enhanced mail facilities.

XFLOW OFF
Although WinPack supports XON/XOFF flow control, PLEASE DON'T USE IT if you have any intention 
of using compressed mail or Yapp file transfer. If you do, you'll get in a terrible mess and the TNC will 
probably have to be switched off and on again to bring it back to life. So set 'XFLOW OFF' unless you 
have a really good reason for not doing.

Saving Your TNC Settings
There is always a risk with a TNC that you will inadvertently reset it and so lose all your settings. The 
following describes an easy way of saving all your settings so you can put them back into the TNC if it 
gets reset.

1. Turn Capture on and set the file name to SETTINGS.TXT.

2. Send to your TNC whatever command will tell it to list all its settings - e.g. DISP.

3. When all the settings have been listed, close the capture file.

4. Open the edit window and Load SETTINGS.TXT. Do any necessary tidying up. E.g. some of the 
settings listed may be status reports and so won't be suitable for sending back to the TNC.

5. Save the file.

Now if you ever need to put the settings back into the TNC, simply use the Send option to send 
SETTINGS.TXT.



Select the handshaking setting that will be used between your PC and TNC.



The receive text boxes can either have horizontal scroll bars - which allow you to bring into view any 
text that is off the screen, or they can have 'word wrap' enabled. This means that when text reaches the 
right hand edge of the window, it wraps onto the next line, rather than disappearing off the screen.



Pressing this button has the same effect as selecting 'Word Wrap' on the 'Options' menu. When word 
wrap is off the button will have a cross on it.



This button allows you to add your signature from the default signature file to a message that you are 
creating. If the edit window is open then the signature will be added at the end of the text in the window. 
If the edit window is not open, but you are connected to another station, then the signature will be sent 
to the TNC for transmission.

Note that this button uses the default signature, if you want to select from a list of available signatures, 
use the "Signature" menu option. Right clicking with the mouse on the signature button gives a short cut 
to the Signature menu.

See also Signature Options



Signature Setup
See also Signature Options.

Auto Signature
If Auto Signature is enabled, every mail message you write will have the default signature file appended 
to it. This means you don't have to press the signature button, or use the Signature menu option to sign 
it. BUT it also means that, if you have this option enabled and you also add a signature manually, you 
will sign the message twice!

In other words, if you have Auto Sig enabled, don't use the signature button or the Signature menu 
option when you are writing messages.

Default Signature
This option allows you to choose which signature file you want to use as your default signature. This 
signature is used by the Auto Sig option, and also when you press the signature button. You will be 
given a list of available signatures, with the current default signature checked.



Signature Options
WinPack allows you to add signatures to messages that you write. It supports multiple signature files. 
These files have an extension of .SIG and live in the main WINPACK directory. One signature file is 
supplied with the program, which is called WINPACK.SIG, but you can easily create others yourself.

The signature files can contain tokens from the tokens list, you can look at WINPACK.SIG for an 
example of how the tokens can be used.

WinPack always regards one signature file as its default signature. If you have Auto Signature enabled, 
this default signature is automatically added to any mail messages that you write. You can change 
which signature file is regarded as the default by using "Options", "Signature Setup", "Default 
Signature".

If you don't enable Auto Signature, you can add a signature to a message by using either the signature 
button or by using the Signature menu option. (This menu option is available both on the top level 
Options menu and on the edit window pop-up menu).

If you use the signature button, the default signature is automatically used. If you use the Signature 
menu option, you can choose from a list of available signatures. Right clicking with the mouse on the 
signature button gives a short cut to the Signature menu.

Please note that, if you create new signature files, you must restart WinPack for these to become 
available on the signature list. This is because the list is loaded when the program starts.



The Tokens List
The purpose of tokens is to enable commonly used information to be put into script files or into the 
signature file by the program.

All the tokens start with the '$' (dollar) character. If the program finds any of these tokens in a script or in 
the signature file, it substitutes them with some other text. Some tokens are used for personal 
information, which is read from PERSONAL.TXT, these tokens are:-

$MYCALL
$1STNAME
$2NDNAME
$QTH
$QRA
$WAB
$BBS
$BBS_PROMPT

To change them you simply edit PERSONAL.TXT by using "Personal/BBS Info" on the Options menu.

$VERSION makes the program version available, it is used in the WINPACK.SIG file.

$WINP_PATH makes the WinPack path available, it is used in SELEDIT.XTR and ALARM.XTR.

All the other tokens are associated with the date and time, which the program reads from your PC 
clock. These tokens are:-

Token Substituted Example
$YYYY the year         1995
$YY the year         95
$MMM the month         Dec
$MM the month         12
$DD the date         31
$HH the hour         17
$NN the minute         52
$SS the second         45
$TZ                          the time zone         UTC

The examples are as if the program was processing the tokens at 17:52:45 on 31st December 1995.

The main purpose of the date/time tokens is for setting the TNC's date and time from a startup script. 
Have a look at the script called SETTIME.TXT which is a good example of how to use tokens. I actually 
use that script as my start up script.



Read Bulletins
Click on an area to find out what it does. Please note that some artistic licence has been taken with the 
picture in order to fit it into the help window. Some of the command buttons at the top of the screen 
have been removed and the command buttons at the bottom have been split into two rows. NB - this 
help window scrolls.



If you mark a section of text in the edit window by dragging the mouse over it and then select this 
option, the text will be 'quoted'. That means "> " will be put at the beginning of each line. The idea is 
that you can load a message from someone else into the edit buffer and quote sections of it in your 
reply. How successful the quoting is depends on the line length used by the sender. However, the 
program attempts to do some intelligent reformatting on the text if the lines are too long.



This option is only available if you have quoted a section of text. If it looks a mess you can select 
unquote to put it back as it was, so long as the quoted text is still selected.



Selecting this option will allow you to add a signature at the end of the text. You will be presented with a 
list of available signature files and you can pick which one you want to use. This option has the same 
effect as selecting "Signature" from the top level "Options" menu.

Note that if you use the signature button rather than this menu option, then the default signature is used 
- you won't be able to select your signature.

See also Signature Options.



Enabling this option means that If the program is minimised (running as an icon) and you have the bell 
enabled, then the program will be restored to normal size every time a beep occurs. The option was put 
in with the idea that you could leave the program running as an icon whilst connected to the DX Cluster 
and it would 'pop up' whenever a spot occurred.



DX Cluster Features
Although WinPack is not written specifically as a program to use for connecting to a DX Cluster, it does 
have several features which make it very useful for that purpose.

The script files allow you to automate the process of connecting to the Cluster, which is very useful if 
you have to connect via two ot three nodes. The RECONNECT script key word allows you to 
automatically reconnect if the link drops out.

The program will run minimized, so you can connect to the Cluster and then minimize the program and 
carry on using your PC for other tasks. When minimized the program uses hardly any of your PC's 
processor time.

If the beep is enabled, the Cluster spot 'bells' will still sound when the program is minimized. Also 
enabling the 'Restore on Beep' option will cause the program to 'pop up' from being minimized every 
time a bell occurs.

When minimized, WinPack looks at every line of text received to see if it is a Cluster 'spot'. If it is then 
the caption of the icon is changed to show the callsign of the station spotted and its frequency. If you 
set the 'Icon on Top' option, then the program icon will always float on top of other programs so you will 
always be able to see the spots.

If you have a sound card in your PC then WinPack can announce the DX 'spots' as they come in. This 
feature is enabled from the "Use Speech" submenu on the Options menu.



Yapp File Transfers
Yapp is the most popular protocol for sending binary files via packet. It was originally devised by 
WA7MBL. There have been a few extensions made to the original system. WinPack supports the most 
popular of these which is FBB style 'crash resume'. This allows you to resume transferring a file after a 
previous attempt failed part way through.

Select one of the following options according to what you want to do.

Using Yapp to Send A File
Using Yapp to Receive a File
Resuming a Yapp File Transfer
Yapp Auto Receive
Yapp Options



The Options Menu
Click on an option to find out what it does. NB - the picture will scroll.



The Yapp Menu
Send a File
This option allows you to send a file using Yapp protocol. For more information see Yapp File Transfers. 
See also Using Drag and Drop.

Receive a File
This option allows you to receive a file using Yapp protocol. For more information see Yapp File 
Transfers.

Receive Resume
This option allows you to    resume receiving    a file using Yapp protocol, when the link has failed part 
way through a previous attempt. For more information see Yapp File Transfers.

Auto Receive
This option allows you to automate reception    of files using Yapp protocol. For more information see 
Yapp File Transfers.



The Help Menu
Help Contents
This option opens the help file at the contents page.

View README.TXT
This option allows you to view the WinPack README.TXT file. This file contains some useful general 
information about the program.

View CHANGES.TXT
This option allows you to view the CHANGES.TXT file, which describes the changes made between 
recent releases of WinPack.

Registration Details
Selecting this option will display the registration information for this copy of the program.

Register WinPack
This option allows you to input your registration information, once you have registered your copy of 
WinPack. For more information on registering the program, see the Registration section of the help.

About...
This option shows some information about the program.



If this option is selected then if WinPack is minimised (run as an icon) the icon will always stay on top of 
other programs ans so remain visible. This is useful since the following information is displayed on the 
icon label.:-

1. If you are connected to the DX Cluster, the callsign and frequency from any incoming 'spots' is 
shown (see also the DX Cluster support section).

2. If you are carrying out a Yapp file transfer, the file name and the number of bytes that have been 
sent/received is shown.



Using Yapp to Send a File
The following describes what to do if you want to upload the file to a BBS. If you are wanting to send it 
to a friend then it is easier, see the comment in step '4'. I'll assume the file is called TEST.EXE.

1. Tell the BBS you want to send it. With FBB you have to go into 'FBB DOS' and then send the 
command YPUT TEST.EXE. With an NNA BBS you use the command YU TEST.EXE.

2. The BBS will then ask you for a description - key in something suitable.

3. The BBS will now prompt you to send the file.

4. (If you are sending the file to a friend then ignore '1', '2' and '3' and start with this step). Select 'Send 
A File' from the WinPack Yapp menu. A standard Windows file dialogue will open up. If you don't know 
how to use a Windows file dialogue, give up at this point and learn how!

5. Using the file dialogue select the file you want to send. The dialogue will open in the PUB directory, 
but you can send a file from any directory on your PC.

6. When you have selected the file, the rest of the process is automatic. The Yapp transfer window 
opens and you don't have to do anything else. If the transfer fails then you will get a message saying 
why.

NB - When a file is being sent, there can be quite a lot of data, typically several thousand bytes, 
buffered within the program and in the TNC. When the screen reports 'Sending End Of File', 
transmission won't immediately finish, all the data that is buffered has still got to be transmitted. So 
don't press 'Abort' thinking the transfer has failed!



Using Yapp to Receive a File
The following describes what to do if you want to download the file from a BBS. If you are wanting to 
receive it from a friend then it is easier, start at step '3'. I'll assume the file is called TEST.EXE - it must 
of course be a file that is on the BBS!

1. Tell the BBS you want to download it. With FBB you have to go into 'FBB DOS' and then send the 
command YGETT TEST.EXE. With an NNA BBS you use the command YD TEST.EXE.

2. The BBS will prompt that it is ready to send the file, and a couple of funny characters should appear 
in the WinPack receive window.

3. If you are receiving the file from a friend then start here.

4.If 'Auto Receive' on the Yapp menu is enabled, the program will now receive the file completely 
automatically.

5.    Select    'Receive a File' from the Yapp menu, the rest of the process is automatic. The Yapp 
transfer window opens and you don't have to do anything else. If the transfer fails then you will get a 
message saying why.



Resuming a Yapp File Transfer
If you have received a large part of a file and then the link between you and the sending station fails, 
this option allows you to resume the transfer from the point at which it failed, SO LONG AS THE 
SENDING STATION CAN SUPPORT FBB STYLE 'CRASH RESUME'.

I'll assume that you want to resume downloading a file called TEST.EXE from a BBS. Most of the 
following procedure is exactly the same as if you were starting a normal download.

1. Tell the BBS you want to download the file. With FBB you have to go into 'FBB DOS' and then send 
the command YGETT TEST.EXE. With an NNA BBS you use the command YD TEST.EXE.

2. The BBS will prompt that it is ready to send the file, and a couple of funny characters should appear 
in the WinPack receive window.

3. (If you are receiving the file from a friend then ignore '1' and '2' and start with this step). Select 
'Receive Resume' from the Yapp menu, the rest of the process is automatic. The Yapp transfer window 
opens and you don't have to do anything else.

4. WinPack tells the other station how much of the file it already has and the transfer carries on from 
there. If the file does not already exist then the program behaves as if normal Yapp Receive had been 
selected. If the transfer fails then you will get a message saying why. If you get an immediate abort then 
the sending station does not support FBB style resume.



Yapp Options
There are some Yapp options that can be altered, but I have deliberately made it a little difficult to 
change them to deter casual 'fiddling'!

To change these settings you have to edit the file PACKET.INI which is created in your WinPack 
directory the first time you run the program. Look for a section in the file titled [YAPP], all the options are 
in that section.

TNC_PROMPT=cmd:
This is the prompt that you get from your TNC. I've never seen one that doesn't use 'cmd:', but I'm sure 
there must be one somewhere! If yours uses a different prompt then you will have to change this 
setting.

TIMEOUT=300
This is the length of time the program will wait, when downloading a file, without receiving anything from 
the sender before it aborts the transfer. It is in seconds, so the default is 5 minutes.

BREAK_LENGTH=3
TNCs can be put into command    mode by sending a 'break' signal. The 'official' length of a break is 
anything longer than two characters. Three characters should be fine - but if you find your TNC doesn't 
seem to respond correctly after a Yapp transfer, until you have switched it off and back on again, you 
can try a higher value.

COMMAND_MODE=CTRL+C
The TNC has to be put into command mode before a Yapp transfer can commence. The default is that 
it is done by sending a 'Control C' character. The alternative is to use a break signal. If you get an error 
message saying that your TNC could not be put into 'transparent' mode then try changing this setting to 
use break. The line must then read COMMAND_MODE=BREAK.
 

CMDTIME=1000
This means 1000 milliseconds. It must be the same length of time as your TNC's CMDTIME setting. 
The default is almost always 1 second, and it is very unlikely that you will ever need to change this 
setting. Please note that the setting used for the TNC may be in units of a second, not a millisecond.



The Transfer Status Window
This window shows the status of both Yapp File Transfers and FBB compressed mail transfers.

File Name or Message Title
For a Yapp transfer, this shows you the name of the file currently being transferred. For FBB 
compressed mail transfer it shows the message title.

File Size
This shows the size in bytes of the file currently being transferred. It is not shown if the transfer is FBB 
compressed mail.

Status
This shows the current status of the transfer, 'Waiting for Initialisation', 'Receiving data', etc.

CPS
This shows the approximate data rate for the current file transfer. To be precise, it shows the total 
number of characters transferred for this file divided by the number of seconds that have elapsed since 
the transfer started. It does not include the time taken in preliminary protocols, only the time whilst the 
actual data is being transferred.

For outgoing transfers, WinPack can only count the data as it goes to the TNC, it has no way of 
knowing if it has yet been transmitted. Therefore, for small uploads, or even for large uploads if your 
TNC has a large buffer, it will initially be very misleading, because all the data 'rushes' into the TNC 
buffer. However, if will then gradually adjust itself to a more meaningful value. The true cps achieved is 
the lowest value it falls back to whilst waiting for the 'FF' from the BBS.

Sent or Received
This shows how many bytes of the file have been transferred. If you are sending the file then it will be 
labelled 'Sent', if you are receiving the file then it will be labelled 'Received'.

Abort
If you press this button then the transfer is aborted. Don't    use it unless you really have to! This is an 
uncontrolled abort and the other end of the link will still think you are transferring the file. All normal 
failures are handled automatically.



If a script has been run that uses the RECONNECT key word, then this button appears. As soon as a 
disconnect occurs the script will be automatically re-run and this will continue to happen until the button 
is pressed. Once the button has been pressed the reconnect feature of the script is disabled and the 
button disappears. This feature is designed to enable you to automatically reconnect to the DX Cluster 
should you get disconnected. See also scripts - how they work.



Normally the receive windows will automatically scroll as new data is received so that the latest data is 
always visible. This can be a nuisance if you are trying to scroll back to view something that has gone 
off the screen, because as soon as some new data arrives the screen scrolls down again!

If you press this Pause Button then the automatic scrolling is disabled and so you are able to scroll 
back and view previous data. Don't leave pause on for too long, because while it is enabled all new 
data that is received is put into a buffer, which can only hold about 30,000 characters.

See also automatic pause facility.



Automatic Pause
Besides being able to use the pause button to stop the receive windows scrolling when new data is 
received, an automatic pause feature is also available.

It works by triggering a timed pause whenever the active receive window is scrolled. At the end of the 
specified time period (usually set to around 15 seconds) the pause is disabled. It can also be disabled 
by clicking the pause button.

By default this feature is disabled. To enable it, proceed as follows:-

1. Make sure WinPack is not running.

2. Edit PACKET.INI in the WinPack directory using Windows Notepad or similar text editor.

3. Look for a section titled [TERMINAL]. In that section there is a line that says PAUSE_SECONDS=0.

4. Change this line to give an automatic delay of how ever many seconds you require.

5. Save the file.

If at any time you want to disable the feature then change the setting back to 0.



Pressing this button should cause a disconnect (assuming you are connected to somebody!) It sends a 
Control_C and then 'd' to the TNC.

This button will not work if you are in the middle of a Yapp file transfer - you must first abort the transfer 
and then disconnect.



Yapp Auto Receive
If you enable this option, then, all the time you are connected to another station, the program will 
continuously scan all received text for the special characters that signify that the other station is trying 
to send you a file using Yapp protocol.

As soon as these characters are received, the program will behave as if Receive Resume has been 
selected from the Yapp menu. Therefore Yapp files can be received without you having to do anything 
at all.

Because resume mode is used, you need to be a little bit careful about leaving files in your download 
directory. If a file exists with exactly the same name as the one being received,    the program might 
attempt to append incoming data to the existing file.



Personal/BBS Information
Click on an area of the window to find out what it does. NB - the picture will scroll.



Input your first name.



Input your second name.



Input your callsign.



Input your QTH (in English that means where you live!)



Input your QRA locator if you know it.



Input your WAB square if you know it.



Input the callsign of your local BBS.



Input some text (as much as possible) from the prompt that the BBS sends. E.g. a BBS might send 
"G4IDE de GB7OPC    04-Jul 20:00z >", so I set the prompt    to "G4IDE de GB7OPC", I obviously can't 
include the time and date because it changes. Whenever WinPack checks for having received the BBS 
prompt, it also looks for a '>' at the end of the line. As far as I know, all BBSs end the prompt with '>'. 
(Funny feeling that someone will tell me I'm wrong!)



Read a message on the BBS, at the top it will have a few lines that say, "To", "From", "Title", etc. or 
similar words. Put here the word that starts the to line. I think in English speaking countries it will always 
be "To".



Read a message on the BBS, at the top it will have a few lines that say, "To", "From", "Title", etc. or 
similar words. Put here the word that starts the from line. I think in English speaking countries it will 
always be "From".



Read a message on the BBS, at the top it will have a few lines that say, "To", "From", "Title", etc. or 
similar words. Put here the word that starts the title line. It may well be "Subject" rather than "Title".



(The following is irrelevant if you are using FBB compressed download).

At the end of each message the BBS will send some text that says "END OF MESSAGE" or something 
similar. Put as much of that text as possible in this field.

My BBS sends something like "============[ End of message 12345 from G4IDE to ..." So I input 
"============[ End of message"

A local NNA BBS sends "<End of message 38869>" (well, not always 38869!)
So you would input "<End of message"



(The following is irrelevant if you are using the FBB unproto beacons).

WinPack does not, at the moment, sort the BBS message list, it simply adds the new lines to the end of 
the old list. What you use for the list command depends on whether your local BBS is FBB or NNA.

FBB
FBB - set the list command to "LR". This results in the oldest message being listed first. The FBB 'L' 
command lists the newest first.

If your BBS is very busy and you frequently get disconnected during a session, you may find that bulls 
often get listed twice - this is because FBB only updates your list pointer when you make a disconnect 
with 'b'. In this case, try using a list command    of "LR $NUM-" this will list from the last message in your 
message list. Using this command    also allows WinPack to process a partial list if you get 
disconnected whilst downloading it.

NNA
NNA - the order in which messages are listed is set by using the "LR'" command. You should set it so 
that the BBS tells you that they are being listed in chronological order. The BBS will save your setting, 
so you only need to do this once. Set the list comand to "L". Please note that on NNA the sysop can set 
the maximum number of messages that you can list, this is to stop you listing    hundreds and hundreds 
of messages if you haven't connected for a long time. If you set WinPack to connect two or three times 
a day    then this won't give you any problems. Alternatively, you can set the list command to "L $NUM", 
this will list from the last message in your message list.



Select this button to accept the new data. It will be written to PERSONAL.TXT.



Select this button to discard the new data,



Read a Message
No all the following options will be available, it depends on whether you are reading a personal 
message or a bulletin.

Next Unread
This option will cause the next unread message (if there are any) to be displayed. The currently 
displayed message will be marked as read, but will not be deleted. If you are reading bulletins and are 
viewing only a part of the message list, e.g. you have selected messages according to a particular "To" 
field, then this option will be disabled.

Keep Message
The message will be marked as having been read, but it will not be deleted.

Delete Message
The message will be deleted. If it is a bulletin then it will be marked with a 'K' (killed) on the message 
list.

Save To File
This option allows you to save the message into a text file. You can choose to put the message in a file 
on its own, or append the message to an existing file - which is useful for keeping related messages 
together.

Reply To Sender
Selecting this option allows you to send a reply to the person who sent the message that you are 
reading.

Reply To Topic
Selecting this option allows you to send a bulletin to the topic relevant to    the message which you are 
reading. By topic I mean the '@' field of a bulletin. Obviously this option is not available if you are 
reading personal mail.

Quick Reply With Auto-Quote
A quick reply option is available by right clicking on "Reply To Sender" or "Reply To Topic". The 
message header form will be filled in with the same values as used when you left click on these 
buttons, but you won't be shown the form. Instead you will be put straight into the edit window as if you 
had been shown the header form and clicked "Ok".

If you mark some text in the message before you right click the reply button, the text will be quoted in 
the edit window preceded with a short header saying who sent the message. For example, if you are 
replying to a bull from G4IDE, the quoted text will be presented something like:-

G4IDE wrote:-
> Some text from G4IDE.
> Some more text from G4IDE.
etc.

The text "wrote:-" is configurable in PACKET.INI, it is REPLY_QUOTE in the [TERMINAL] section. You 
can suppress it by changing it to "REPLY_QUOTE=*"

Using the Quick Reply feature will probably give you a better idea of how works than this explanation!



Please see The Main Screen help for for information about this menu.



Please see The Main Screen help for more information about this tool bar.



If you are viewing the whole of the message list then this bargraph will show you where abouts you are 
positioned in the list. You can move around the list by clicking on the bar. If you are viewing only an 
extract of the list then the bargraph is disabled, but the caption will tell you how many messages are in 
the extract.

(When the list is viewed it is loaded in sections and so the vertical scroll bar on the list only moves you 
around within a section).



This is a list of the messages on your local BBS. It is accumulated by WinPack connecting to the BBS 
(either automatically or by you using the "Auto BBS Session" option).

The first character on each line is the status of the message. If it is blank then you have not 
downloaded the message. If it is 'N' then you have downloaded the message but not read it. 'Y' means 
downloaded and read. 'K' means downloaded, read and killed. '*' mens it will be downloaded during the 
next Auto BBS Session.

If you double click on the line, the an action occurs according to the status:-
Status Action
    ' '                  The status becomes '*'
 '*'                    The status becomes ' '
'Y' or 'N'                    The message is displayed for reading.

If you hold down the Ctrl key while you click, different actions occur:-
Status Action
 'Y' or 'N' The message is killed, the status becomes 'K'.
 'K' The status becomes ' '.

You can move around the list using the scroll bars, PgUp/PgDn or by clicking on the bar graph at the 
top of the screen.



This button displays the next unread message.



This button allows you to filter the message list by topic. You will be prompted if you want to list all the 
topics. If you say "no", you simply key in the topic of interest and all messages matching it will be listed. 
If you say "yes" , the whole message list is processed and a list of all the topics in it is shown, along 
with the count of the messages for each topic. You can then select a topic of interest from the list.

If you choose to list all the topics and you have a large message list, reading it and listing all the topics 
*can take some time*. However, once you have viewed the topics list in a bulls reading session, then 
displaying it again is instantaneous.

The prompting as to whether or not you want to list all the topics can be over-ridden by editing 
PACKET.INI.

A maximum of 350 messages can be displayed in the list when you use this filter.



This buttons allows you to filter the displayed message list by sender. A maximum of 350 messages can 
be displayed in the list when you use this filter.



This button allows you to filter the message list by title. A maximum of 350 messages can be displayed 
in the list when you use this filter.



If you select this button then the message list is restricted to showing only messages for which text is 
available.



This button clear any filters and display the whole list.



This button positions the list so that    the top line on the screen is one message before the first new 
message. (That is a really bad explanation, so try it and it should be obvious!)



If you drag the mouse to mark a block and select DELETE, then all the message list lines in the marked 
block will be deleted. (If no text in the list is marked, selecting Delete has no effect.)

Lines marked 'Y', 'N' or '*'. will normally not be removed. If you want the act of pruning to delete list 
entries for downloaded bulls marked 'Y', and also delete the bulls corresponding to those entries, then 
check "Block Delete Bulletins" on the Options menu.
 
NB - if your bulletins list command in Personal/BBS Info is set to "LR $NUM-", or anything else using 
$NUM, try to avoid deleting the last line of the list.



The Prune button works differently according to whether or not a block of lines in the list has been 
marked by dragging the mouse:-

If no text in the list is marked, then the bulletins list will be pruned down to approximately the number of 
lines set in the "Bulletin List Prune Size" menu option.

If you drag the mouse to mark a block and select PRUNE, then all the message list lines from the top of 
the list to the end of the marked block will be pruned.

Lines marked 'Y', 'N' or '*'. will normally not be removed. If you want the act of pruning to delete list 
entries for downloaded bulls marked 'Y', and also delete the bulls corresponding to those entries, then 
check "Block Delete Bulletins" on the Options menu.

NB - if your bulletins list command in Personal/BBS Info is set to "LR $NUM-", or anything else using 
$NUM,    try to avoid pruning the last line of the list. 



Select DONE when you have finished reading bulletins.



Fonts...
When choosing a font please bear in mind the following:-

Most Windows fonts are proportionately spaced, also most Windows fonts cannot display the IBM 
graphics characters that are frequently used in packet messages. From version 5 onwards, WinPack 
only makes available fixed pitch fonts. It also will not allow Windows to 'fake' a font style that doesn't 
really exist. These changes were introduced in an effort to stop complaints from users who were 
making their own problems by choosing crazy fonts!

The default font for all the text windows is WinPack 11 point. You may prefer one of the other sizes. The 
12 point is an exact replica of a DOS VGA font. If you have problems with the WinPack font, try 
Terminal.

On all the font selections for the text windows, the text background colour is always whatever you have 
set for Window Background colour in the Windows Control Panel 'Color' utility.

Receive Window 1
This option allows you to set the font size and text foreground colour for the upper receive window.

Receive Window 2
This option allows you to set the font size and text foreground colour for the lower receive window.

Transmit Window
This option allows you to set the font size and text foreground colour for the transmit window.

Printer
This option allows you to set the font characteristics for the printer. If you select a font that your printer 
doesn't support, Windows will    try and find a    near match for it. NB - if you get in a mess, the default 
font is Courier and the default size is 12 point.



Bulletin Deleting
Block Delete Bulletins
If you prune the bulletins list, or delete a block of lines from it, then normally any lines within the deleted 
section for which a bull has been downloaded and which have a status of    'Y' will not be deleted - to 
get rid of those lines you must first kill the bulletin.

If you enable "Block Delete Bulletins", these lines will be deleted and the associated bulletins will 
automatically be killed.

NB - you cannot delete bulletins with a status of '*' or 'N' in this way. WinPack will assume that if you 
have marked bulletins, you want to download them, and if you have downloaded them, you want to 
read them. However, bulletins marked 'D' will always be deleted, irrespective of the setting of "Block 
Delete Bulletins", because they are 7plus parts from which the 7plus has been extracted and put in the 
7EXTRACT directory.

Bulletin List Prune Size
If in "Read Bulletins" you click the Prune button, and you haven't marked a block of bulletins, then the 
list will be pruned down to approximately the number of bulletins set by this option. For example if you 
have "Bulletin List Prune Size" set to 2,000 and you have 10,000 lines in your bulletins list, then the first 
8,000 lines will be deleted and the last 2,000 will be left.

The final number left in the list may be slightly more, depending on the setting of "Block Delete 
Bulletins" and whether you have any bulletins in the section to be deleted which are marked '*' or 'N'.

The default value for "Bulletin List Prune Size" is 5,000.



Any program like WinPack that uses message list processing has to know where the various columns 
are in the listing. If    it doesn't then it will not be able to mark messages. This menu option allows you to 
do that.    NB - the status line prompts you what to do. See also message list columns.



This option allows you to input your personal information and also the information that WinPack needs 
to know about your local BBS.



7plus Send/Receive
This section tells you how to send files by using 7plus, how to automatically decode 7plus files that are 
received as personal mail or as bulletins in Auto BBS Sessions, and how to automatically decode 7plus 
if you are manually connected to the BBS and reading messages.

If you don't know what 7plus is, or why it is used, see What Is 7plus.

Using Seven Plus To Send Files
When you use "Mail", "Write A Message", there is a button available labelled "7plus". If you press this 
button, you will be able to select a file to send using 7+.

Once you have selected the file you are given the option of zipping it to make it smaller, you need 
PKZIP on your PC for this to work. WinPack uses a PIF file, PKZIP.PIF in \WINPACK, to run PKZIP. By 
default it assumes that the directory where PKZIP is stored is on your DOS path. If it isn't then you need 
to edit the PIF file and put in the full path for PKZIP. 

The 'parts per day' release works as follows:- Say the file you are sending has been split into 9 parts 
and you choose to release 3 parts per day. All WinPack mail files have a time stamp encoded in the file 
name that is used to store them on your PC. The Seven Plus parts will be time stamped 3 with the 
current time, 3 with the current time + 1 day and 3 with the current time + 2 days. When WinPack 
uploads mail to the BBS, it will not send a file if the time stamp is ahead of the current time, so your files 
will not be sent until the current time has passed their time stamp.

Seven Plus Receive During Auto BBS Sessions
PLEASE NOTE - from V6 onwards, WinPack handles received 7plus slightly differently to earlier 
versions. There are now separate directories used for extracted 7plus parts and for decoded 7plus files. 
Also, a record can be kept in a log file of all 7plus decode attempts.

If the "Auto 7+ Decode" option on the "7plus Setup" submenu is checked, then all personal mail and 
bulletins received during Auto BBS Sessions are scanned to see if they contain 7+ data. If they do, the 
data is extracted and put in the WINPACK\7EXTRACT directory.

When all the parts of a 7+ set have been received, WinPack will attempt to decode the file and will send 
you a system message as to whether the decode was successful or not.

If "Log 7plus Decode" on the "7plus Setup" menu is checked, then, every time that WinPack attempts to 
decode a 7plus file, an entry will be made in the log file 7PLUSLOG.TXT. By looking at the log you can 
see when a file was decoded, if the decode was successful, whether it was received as a bulletin or as 
personal mail, and who sent it. You can view the log file with Notepad, or you can load it into the 
Winpack editor.

If the decode is successful then the parts are either deleted or moved to the 7PLUSOLD directory, 
depending on the setting of the "Keep 7+ Parts" option on the "7plus Setup" menu. Normally the 
decoded file will be moved to the 7DECODE directory. However, if a file by the same name already 
exists in the 7DECODE directory, the decoded file will be left in the 7EXTRACT directory. Both the 
system message and the log entry will show whether or not the file was moved.

If a .COR file is received for a 7plus file for which all the parts have been received but which contains 
errors, WinPack will attempt to use the .COR file to repair the 7plus file.

If the decode is unsuccessful then a .ERR file will be produced in the 7EXTRACT directory.

The above process can obviously go wrong in several ways! If some parts of a set are never received, 
the parts that have been received will languish for ever in the 7EXTRACT subdirectory. Also, if you are 



happen to receive two different sets at the same time with the same file name (this does sometimes 
happen) then things can get very messy!

Therefore, it is a very good idea to occasionally look in the 7EXTRACT directory and delete any rubbish 
that has accumulated.

If a .ERR file is produced then to send it to the sender of the 7+ data do as follows:-
1. Select "Mail", "Write a Message" and start a message to the sender.
2. From the edit window menu select "Load" and load in the .ERR file form the 7EXTRACT directory.
3. Send the message.

Seven Plus Receive During A Manual Connect
If you want to read and decode a 7plus file whilst you are manually connected to the BBS, then you 
must do the following:-

1. Make sure that "Scan Capture Files" on the "7plus Setup" sub-menu is checked.
2. Manually connect to the BBS.
3. Click the Capture button, or select Capture from the File menu and input a file name. This file is only 
used as a temporary store for the data, so, if you wish, you can always use the same name and 
overwrite the file each time.
4. Read the message or messages with the 7plus in them - you can capture several in the one file.
5. Close the capture file - and the 7plus will be extracted and decoded, just as if it was in a message 
that had been read in an Auto BBS Session.



The Write Message Window
Click on an area to find out what it does. NB - the picture will scroll.



Select a message, either by double clicking it or by moving the cursor bar to the required line and the 
pressing the "Ok" button.



Read Mail
In the "Read Mail" window, select a message, either by double clicking it or by moving the cursor bar to 
the required line and the pressing the "Read" button.

You can use the Delete button to delete messages you have read. If you want to delete messages that 
you haven't read, hold down the <Ctrl> key and click the Delete button.

The Archive button works exactly like the Delete button, except that, before deleting the message, it 
makes a copy of it in ARCHIVE\RECEIVE. It names the archived copy according to the sender of the 
message.

The message Status can have the following values:-
 '*' The message has not yet been downloaded.
'N' The message has been downloaded but not read.
'Y' The message has been read.
'R' The message has been read and a reply has been sent.
'D' The message is 7+ and has been processed.
'S' The message has been processed by a server.
'X' This is a message which is not in the normal WinPack format.

'X' status messages may be created by other programs.
WinPack uses an 'X' status message called YAPPLOG.TXT
to report Yapp file transfers.



The Mail Submenu
Read Mail
This option allows you to read personal mail.

Write a Message
This option allows you to    write a message - either a personal message or a bulletin. See also the write 
message window.

Edit a Message
This option allows you to edit a message that you have written, before it is sent to the local BBS.

Delete a Message
This option allows you to delete a message that you have written, before it is sent to the local BBS.

Read Bulletins
See Reading Bulletins

Auto BBS Session
See running an Auto BBS Session

Mail Options
This option displays a form which allows you to specify whether you want to use compressed 
forwarding and also whether you want to use the FBB unproto message list beacons, if they are 
available from your local BBS. For a full discussion of this topic, see enhanced mail facilities.

Repair Bull List
This option allows you to repair the bulletins list should it ever become corrupted for any reason. It 
makes sure that there are no corrupted lines in the list and that no bulls are marked with 'Y' or 'N' if the 
downloaded bull no longer exists. Corruption is unlikely to occur, but one sure sign of it is when you 
click a bull marked 'Y' or 'N' to read it, and nothing happens.

Change LASTNUM
This is an advanced option! It is unlikely that most people will ever need to use it. It is only in WinPack 
to compensate for a    problem which occurs very occasionally with FBB.

WinPack has an internal variable called LASTNUM. If you use the FBB unproto headers, LASTNUM is 
used in deciding the sync request number. If you don't use the unproto headers, but your "List Bulletins" 
command in "Personal/BBS Info" is set to something like "LR $NUM-", then the value of LASTNUM is 
substituted for $NUM when the command is sent to the BBS.

On very rare occasions FBB BBSs seem to misbehave and will refuse to send the beacon 
corresponding to a particular message number, so WinPack repeatedly syncs on a number and the 
BBS insists on sending the headers starting from the next number. Or FBB will not respond correctly to 
an "LR nnnnn-" command. E.g. WinPack sends "LR 12345-" which means "list all bulletins from 12345 
onwards", and the BBS will respond "There are no messages", even though there are lots of bulletins 
with numbers higher than 12345.

This menu option allows you to adjust LASTNUM and so work round these problems. The most you 
should ever need to adjust it is upwards by one.

DON'T USE THIS OPTION UNLESS YOU ARE ABSOLUTELY SURE ABOUT WHAT YOU ARE 



DOING!



Reading Bulletins
When you select the "Read Bulletins" option on the "Mail" submenu, the message list will be displayed, 
positioned at the start of    any new messages that have been added since you last used this option. 
You can move around the list using the scroll bars, PgUp/PgDn or my clicking on the bar graph at the 
top of the screen.

To mark a message for downloading, double click anywhere on the line and an '*' will be placed at the 
beginning of the line. Or you can move the text cursor to anywhere on the required line and press 
<Return>. A second double click or <Return> will    clear the '*'.

A message that has been downloaded and not read will be marked 'N', one that has been read will be 
marked 'Y'. A message that has been read and deleted will be marked 'K'. If you want to clear the 'K' so 
you can mark the message for downloading again then hold down the Control key and double click.

To read a message that is marked 'N' or 'Y' simply double click that message. If you hold down the 
Control key and double click a message marked 'N' or 'Y' then it is deleted.

The buttons at the bottom of the screen have the following functions:-

UNREAD - display the next unread message. If you have made a selection based on "To", "From", etc, 
then this button becomes:-
DUMP - this allows you to put the text from all the bulls in the current list selection into a file. Because it 
can create quite a large file, you will first be asked to confirm that this is what you really want to do.

FROM - filter the displayed message list by sender.    When you are prompted to input the required 
"From" you can use "*" as a wildcard. E.g. If you input "G4*" then all messages from callsigns starting 
with "G4" will be listed.

TO - filter the message list by topic. When you are prompted to input the required "To" you can use "*" 
as a wildcard. E.g. If you input "DE*" then all messages to topics callsigns starting with "DE" will be 
listed.

TITLE - filter the message list by title. Input text that you want to occur somewhere in the title.

ALL BULLS - list all the messages for which text is available.

ALL LIST - clear any filters and display the whole list.

NEW - positions the list so that    the top line on the screen is    one message before the first new 
message. (That is a really bad explanation, so try it and it should be obvious!)

DELETE - See Deleting Bulletins from the list.

PRUNE - See Pruning Bulletins from the list.

DONE - finished reading bulletins.



Auto BBS Session
Selecting the "Auto BBS Session" option on the Mail menu, or clicking the mailbox button, causes 
WinPack to start an automatic connection to the BBS. Exactly what happens will vary slightly according 
to what Mail Options you have selected. You may be prompted as to whether you want this to be a mail 
only session. If you only want to upload messages and collect any personal mail that is waiting on the 
BBS, then say "Yes". If you want to also collect any bulletins that you have selected and collect the 
message list, then say "No".

WinPack will then connect to your local BBS and carry out the following actions:-

1.Read any waiting personal mail and then kill it.
2.List the messages (if you answered "Yes" to the collect message list question). BUT see the comment 
below.
3. Download any marked messages, including any that have been automatically marked as a result of 
listing the new messages.
4. Upload any messages that you have written.

Obviously the message list is not downloaded if you are using the FBB unproto beacons.

If you have mail to forward to the BBS, and you are using compress forwarding, WinPack will not collect 
the message list on that session, because of the way that FBB handles disconnects. The only exception 
to this is if you are using a list bulletins command in "Personal/BBS Info" of "lr $num-".



The Scripts Submenu
Play a Script
This option allows you to play a script. For more information select scripts - how they work. Ctrl+S is a 
short cut to this menu option.

Edit a Script
This option allows you to edit a script file.



Writing Messages
To write messages, both personal mail and bulletins, you use the "Write a Message" option on the Mail 
submenu. (There are also options for editing and deleting messages that you have written).

From V6.3 onwards, WinPack has support for mailing lists, which allows you to send the same 
message to several different recipients. See Creating And Using Mailing Lists.

WinPack will upload messages that you have written and download mail from your local BBS during an 
Auto BBS Session. To read mail that you have received you use the "Read Mail" option on the Mail 
submenu.

See also the write message window.



Remote Access
If someone connects to your system, then there are a few remote options available. It's a good idea to 
put something in your TNC CTEXT about "/HELP to get help". The remote options are (all case 
insensitive):-

/BYE - disconnect.

/HELP - sends the file WINPACK\USERHELP.TXT.

/MSG - to leave a message.

/DIR - list the files in your WINPACK\PUB directory.

/CD    - change directory.

/YGET <filename> - download <filename> using YAPP.

/GET <filename> - download <filename> (ASCII).

/TALK - alert you that the user wants to talk.

All the commands can be abbreviated to a minimum of / and one letter. E.g. /help, /hel, /he and /h are 
all valid.

To upload a file using YAPP they simply send it. As long as you have "Auto Receive" checked on the 
YAPP submenu, the program detects they are sending a file and stores it in the 
WINPACK\DOWNLOAD directory.

Shouldn't DOWNLOAD be UPLOAD? No, not really. The DOWNLOAD directory is primarily where you 
put files that you download from a BBS, i.e. that you receive. So if someone sends you a file, it goes in 
the DOWNLOAD directory. Clear as mud?

All the above commands are internal remote commands. WinPack also allows the list of remote 
commands to be extended by the use of external programs. These work very much like FBB PG 
programs. See WinPack External Programs.



WinPack and your Local BBS
For WinPack to work correctly, you must have the paging option turned off in your setup on your local 
BBS. On FBB this is the 'OP' command, which works as a toggle - you need it to report OFF. Also on 
FBB 'LC *' is a good idea.

The following applies mainly to FBB BBSs and people who have been using TPK:-

If you have been using a packet program that never actually uses the 'l' or 'lr' command, then, the first 
time that WinPack connects and sends 'lr' the list could be *huge*. Here in the backwoods of 
Lincolnshire that isn't a problem, but in some areas listing a thousand or so messages might not make 
you too popular. To avoid this you can do the following:-

1. Manually connect to the BBS.
2. Use 'OP' to set paging ON.
3. Send 'L'.
4. When you get the first "... Continue <A>bort ..."          message, send    'A'.
5. Use 'OP' to set paging OFF.
6. Send 'b' to disconnect.

Your list pointer is now updated to the top of the    message list.

If you are using the FBB message beacons, the above procedure is not needed, but you *must* ask 
your sysop to give you 'U' status on the BBS.

If your FBB BBS profile is set so that, when you connect, the BBS lists any new personal mail, it is 
worthwhile disabling this feature. It isn't needed, because WinPack will find out what new mail you 
have, and it wastes air time. Also, the more text you receive before you get to the first BBS prompt, the 
more chance your BBS.TXT script file has of seeing something in the incoming text that looks like a 
BBS prompt - which will totally mess up the auto BBS session. To stop the BBS sending you the list of 
new mail when you connect, send the command 'OM'. It is a toggle - alternately enabling and disabling 
the feature.



Input the frequency to be used for entries in AUTOLOG.TXT.



Input the power to be used for entries in AUTOLOG.TXT.



Input the mode to be used for entries in AUTOLOG.TXT.



This is the type of the message. It can be 'P' for personal or 'B' for a bulletin.



For a bulletin this field is the BULLETIN TOPIC    - a list of topics is available from which you can select, 
or you can key in a topic of your own choice. 

If possible it is better to use a selection from the list. By using a topic that is in common use you are 
more likely to get replies to your message. For an explanation of each topic in the list, select the 
Bulletin Topics List.

To drop the list down, click on the arrow or press Alt and cursor down.

NB - if you think this is a bad idea, simply delete BULLS\TOPICS.TXT, you will then not get the list. Or 
you can edit this file and put in topics of your own choice.

For a personal message this field is the callsign of the recipient. You can also use a mailing list - see 
Creating And Using Mailing Lists.



This is the name of the recipient. It is only useful as a mnemonic for storing in the address book.



For a personal message this is the home BBS of the recipient. For a bulletin it is the circulation area - 
GBR, EU, WW, etc.



This is the title of the message - up to 30 characters long.



Pressing this button means that you accept the header information and you will then be able to input 
the message text.



Pressing this button cancels the message.



If you press this button, the header will be filled in from the currently highlighted entry in the address 
book.



Pressing this button causes the information currently in the header to be added to the address book. To 
create address book entries without sending a message, you can keep filling in the header and 
pressing "Add" then press "Cancel" when you have finished.



Pressing this button deletes the currently highlighted address book entry.



This is the list of callsigns and addresses in the address book. The list will scroll. It is updated using the 
"Add" and "Delete" buttons. To use an entry to fill in the header, you can highlight it and press "To", or 
press <Return> when an entry is highlighted, or double click on an entry.



(The following is irrelevant if you are using the FBB unproto beacons).

This is the command that WinPack sends to the BBS to get it to list your unread personal messages. 
For an FBB BBS it should be 'LN', for an NNA BBS it should be 'LM'.



This option allows you to specify if you want to use WinPack with a BBS that has password access for 
its users. On this version of WinPack you can specify either NNA style or FBB sysop style passwords. 
See also Password Support.



Password Support
Some BBSs only allow their users full access if they supply a password. This normally works on the 
basis that the user sends some sort of trigger (e.g. '@' with NNA style passwords) the BBS then sends 
something back, often a string of numbers, and the user has to give the correct response.

WinPack has internal support for F6FBB sysop style passwords and G1NNA style passwords. Other 
types of password are supported by external servers. Servers for virtually all BBS password systems 
are available. A bulletin to WINPAC, saying what sort of password system your BBS uses is the best 
way to get information.

To automatically send an FBB or NNA password, you have to tell WinPack the style of password being 
used, provide a suitable BBS.TXT script file, and provide a text file containing the required user 
password information.

F6FBB Sysop Style Passwords
1. Select 'F6FBB' on the 'Options', 'Password' submenu.

2. Use the script file SCRIPTS\FBBPASS.TXT as a guide for your BBS.TXT script file.

3. Put your password matrix in the file WINPACK\PASS_FBB.TXT - an example file is provided. Please 
note that you may need to remove the row and column headings from your matrix as supplied by your 
BBS sysop. If the 'matrix' as supplied by your sysop is a single row of characters you can leave it like 
that. It doesn't have to 8 rows of 10 characters.

G1NNA Style Passwords
1. Select 'G1NNA' on the 'Options', 'Password' submenu.

2. Use the script file SCRIPTS\NNAPASS.TXT as a guide for your BBS.TXT script file.

3. Put your password matrix in the file WINPACK\PASS_NNA.TXT - an example file is provided. Please 
note that you may need to remove the row and column headings from your matrix as supplied by your 
BBS sysop.



Printing
You can print the contents of either of the receive windows or the edit window by pressing the Print 
Button on the tool bar. If you are viewing messages then you can print the message being read or you 
can print the message list.

If you aren't using split receive windows and the edit window isn't visible, WinPack will print the main 
window, otherwise you will be offered a choice as to which window you want to print.

If there is any selected text in the window, then you will print the selected text, otherwise you will print 
all the text in the window. 

Because of an apparent problem with Windows (I daren't say bug!) the title line of the Print Dialogue 
Box simply says "Print" even though I am telling it to say "Print receive window" or "Print edit window".

You can use Print to save a message to a file. If you check the "Print to file" box in the Print Dialogue 
then you will be prompted for a file name and the text will be saved in that file.

You can change the printer font by using the "Options", "Fonts...", "Printer" menu option.



If you press this button, you will be able to select a file to send using 7+. For more information see 
Seven Plus (7+).



This option gives access to a submenu that allows you to select when WinPack will use your sound 
card to announce various events. It can announce connections and disconnections, the arrival of new 
mail, the callsign and frequency of 'spots' when you are connected to a DX cluster, and it will tell you 
when someone is calling you with the /talk remote command.

There is also an option on the submenu to replay the last announcement. Control-A is a hot-key to this 
option.

For more information see Using Speech.



Using Speech
 WinPack can use your sound card to announce various events. It can announce connections and 
disconnections, the arrival of new mail, the callsign and frequency of 'spots' when you are connected to 
a DX cluster, and it will tell you when someone is calling you with the /talk remote command. The 
options are enabled or disabled from the "Use Speech" submenu on the Options menu.

For these options to work you must have a sound card fitted and an MCI Sound driver installed. If you 
have problems then check in Control Panel, Drivers and see if it lists "[MCI] Sound". If it doesn't then 
select "Add..." and see if an MCI Sound driver is available on your system.

If you try to enable these options and have a sound card fitted, but get lots of messages about 
MCI.VBX not being loaded and MMSYSTEM.DLL not being found, then your PC does not have 
multimedia extensions - probably because you are running Windows 3.0.

When you connect to a station, the announcement is made up from the file CONN.WAV (which says 
"connected to") and the WAV files for the individual characters in the callsign. You can, if you wish, 
create your own WAV files for particular stations. For instance, if you create GB7OPC.WAV and put it in 
the WINPACK\WAV directory, then everytime you connect to GB7OPC this file will be used. This allows 
you to get a more natural announcement for stations to which you frequently connect.

If you create your own WAV files, they must be 8 bit, mono, 11kHz sampling rate.

WinPack will also play MIDI files. If there isn't a .WAV file with the name for which it is searching, then it 
will look for a .MID file.



Drag and Drop
WinPack supports "drag and drop" of files from File Manager.

First of all, please note that there are some restrictions on when you can drag and drop, the rough rule 
is that if anything else is going on, e.g. reading mail, running a script, reading bulls, then the drag and 
drop is ignored.

If you drop a file onto WinPack, it normally assumes that you want to send it to the TNC (there is an 
exception to this - see the comments below about the edit window). If the file extension is ".TXT" or 
".BAT" then it sends it as an ASCII file. If the extension obviously means that it is a binary file 
(".EXE" ,".COM", ".ZIP", etc.) then it will send it using YAPP protocol. If the file type cannot be 
determined then you will be prompted as to whether it is a binary or ASCII file.

NB - you will always be prompted about ".DOC" files, since that extension is often used for text files in 
DOS, but is also used for Microsoft Word files.

Be careful using "drag and drop"! If the file is an ASCII file then it is sent to the TNC even if you aren't 
connected - because it could be a setup file. You won't be allowed to start a YAPP send if you aren't 
connected to another station. However, remember that, unless the other station is running software that 
supports auto-detect of YAPP transfer (such as WinPack!), you must make sure that it is ready to 
receive the file before you "drop" it.

If the edit window is open then drag and drop works differently. If the file is dropped in the edit window 
then it replaces the text currently in the window. If it is dropped anywhere else then it is ignored.



Select A Script
Select the script you want to play. For scripts that have a DESCRIPTION line in them, the list shows the 
description, otherwise it shows the file name.

If a script has a 'hot key' then it is shown, this is only as a reminder.

To make your selection, move the highlight bar to the appropriate script and then press <Return> or 
click the "Ok" button.



This option allows you to enable or disable the WinPack remote commands. These are the commands 
prefixed with / that are available to users of your system. See also Remote Access Commands.



WinPack External Programs
WinPack has a list of remote commands, all preceded with /,    that are available to users of your 
system for carrying out functions like downloading files, or leaving you a message.

It is possible to add to this list of commands by using external programs. The way it works is that if 
WinPack receives    a command preceded with / that is not on its internal list, it looks to see if it has an 
external program available by that name. If it does then it will start that program.

An example external program is supplied with WinPack, it is called LOC and it works out distances and 
bearings between locations. A user of your system would send /LOC to activate it.

You can also run the external programs yourself from within WinPack. If you aren't connected, simply 
input the command just as a user would. If you are connected, then you precede the command with a 
singled quote character, e.g. '/LOC. (This format can also be used when you aren't connected).

External programs live in the EXTERN subdirectory. To create an external program you must have 
some knowledge of programming. However, anyone who has written an FBB PG program will find it 
very easy to write a WinPack external program.

Anyone who is interested in exploring the possibilities of external programs should unzip the file 
EXTERN.ZIP on the installation disk, and have a look at the example program called DEMO. It is 
written in VB, but FRMEXT.FRM can be viewed in a text editor, and the comments at the top of the 
ExternAction subroutine explain how to write a WinPack external program. Of course, if you want to 
write program using VB then you can use DEMO as a starting point.

What can external programs do? Well, a CD-ROM callbook access external program is an obvious 
idea, or some sort of information database, or how about a noughts and crosses game? Or even an 
adventure game?



Input the baud rate that you want to use between your TNC and your PC. Use 9600 unless you have a 
good reason not to. Please note that the sixth speed option - 38400 - can be toggled between 38400 
and 57600 by right clicking on that button.



Pressing this button has the same effect as selecting "Read Mail" on the Mail menu. If that menu option 
is disabled by the current state of the program, this button will have no effect.



This button has the same effect as selecting "Write a Message" on the Mail Menu. If that menu option is 
disabled by the current state of the program, this button will have no effect.



This button has the same effect as selecting "Read Bulletins" on the Mail menu. If that menu option is 
disabled by the current state of the program, this button will have no effect.



Enhanced Mail Facilities
This section describes three facilities that are available with some BBSs. They help to make reading    
mail and bulletins, sending mail and collecting the BBS message list easier and more efficient.

The Unproto List (F6FBB BBSs only)
If an F6FBB BBS has the unproto list facility enabled, then, each time that a new message arrives at 
the BBS, it will send out an unproto transmission giving details of the message. The transmission looks 
like:-
GB7OPC>FBB:
10758    B        928 WINPAC@GBR        G8MZX    951005 Servers?
If your local BBS is sending the unproto list, these beacons are very obvious. Software that can use the 
beacons accumulates them into a message list. Therefore it becomes unnecessary to connect to the 
BBS and use 'l' or 'lr' to update your message list. The first software to make use of this facility was 
F1EBN's brilliant TPK program.

Synchronisation Requests
A mechanism is available by which your system can tell the BBS that it has missed some message 
beacons. This will happen either because a beacon collided with another transmission on the frequency 
or because you have had your system switched off. You can request the BBS to resend all the message 
beacons starting from a particular number by sending out a synchronisation (sync) request.

WinPack will automatically send out a sync request whenever it hears a beacon with a message 
number higher than the next number that it expects to hear (it keeps a record of the last number that it 
has received). There is a degree of sophistication built into this to stop it sending out too many sync 
requests within a short time period.

You can send out a sync request manually by pressing F5 - a script is supplied with F5 as its hot key 
that simply makes use of the FBBSYNC script keyword. You may also find it useful to put FBBSYNC as 
the last line in your STARTUP.TXT. This will make sure that your message list starts to be updated as 
soon as WinPack starts up.

In order to be able to send sync requests, your TNC's UNPROTO parameter must be set to the BBS 
callsign. E.g. 'UNPROTO GB7OPC'. The only exception to this is if the BBS can't hear you direct, in 
which case the UNPROTO setting must include a suitable digipeater path, e.g. 'UNPROTO GB7OPC 
VIA STUMP'. This is identical to the requirement for TPK.

Compressed Download
Some F6FBB BBSs and some G1NNA BBSs allow the user to download messages in compressed 
format. This reduces the usage you make of the channel and can make the download process 
significantly quicker. To read a message in compressed format from an F6FBB BBS, the user's software 
must send something like 'F< 12345' - this would tell the BBS to send message number 12345 in 
compressed format. With a G1NNA BBS the protocol is slightly more complicated, but the end result is 
the same.

Compressed Forward
You can forward mail to the BBS in compressed format, this should work for any type of BBS provided 
that it supports FBB style compressed forwarding. 

WinPack-Specific Issues
So far I have described what is available from the BBS, the following comments are specific to how 
WinPack uses these facilities.

Obviously WinPack supports the F6FBB unproto list, compressed download and compressed forward. 



(If it didn't, I wouldn't have bothered with this section!) In doing so it behaves very much like TPK, but 
there are some differences:-

1. The Unproto List (and TPK)
You can use compressed download and compressed forward even if your local BBS does not send out 
the message beacons. (You could do that with TPK, but it required the use of an external program to 
create the message list - such as my MAKELIST software). The Mail Options dialogue in WinPack 
allows you to enable compression, but not to select to use the unproto list. This means that the 
message list will be collected using 'l' or 'lr', but mail will be downloaded and forwarded in compressed 
format.

If you turn your system off a lot, you may find that it is better not to use the unproto list, even if your 
local BBS sends the beacons. That is because most BBSs impose a limit as to how far back they will go 
with the beacons in response to a sync request. E.g. if you start up WinPack and it sends out a sync 
request for message number 1000 when your local BBS has now reached number 1500, it is unlikely 
that the BBS will go back that far. It will probably send a special unproto message to tell your system to 
reset its message number to, say, 1400, so you will never see the message titles between 1000 and 
1400.

2. FBB 'Version 1' protocol
 WinPack supports the 'Version 1' extension to the FBB compressed forward protocol, and therefore 
supports FBB forward resume. That means if you lose the connection to your local BBS in the middle of 
uploading a message, the upload can be restarted from the point at which the disconnection occurred. 
To use this facility your local BBS must have Version 1 protocol enabled, some do not.

3. R: Lines
If you have ever read a message by using 'v <msg_no>' rather than 'r <msg_no>' then you will know 
that at the top of each message there are lines that contain routing information. Sometimes this 
information is useful - but not often! If the message has travelled a long way then it is not unusual for 
the R: lines to take up a lot more space than the actual message! If you use 'r' then the R: lines are 
squashed into a simple list of BBSs through which the message has passed. E.g. !GB7OPC!GB7IOE!
GB7ZPU! etc.

When compressed download is used, FBB sends all the R: lines. WinPack squashes the R: lines very 
much as if you have read the message on the BBS using 'r', *except* that the R: line of the BBS from 
which the message originated is left intact. I think this is the optimum way to process R: lines.



Mail Options
In its default mode, WinPack downloads the local BBS message list by sending 'l' or 'lr', it downloads 
messages by using 'r <msg_no>' and it forwards messages in a plain text format (MBL/RLI protocol).

This works fine, but there are usually more efficient ways of carrying out these tasks. If your local BBS 
is running F6FBB software, it may be possible to accumulate the message list from the FBB unproto 
beacons. Also, with both F6FBB and G1NNA BBSs, compression can often be used for both forwarding 
mail to the BBS and for reading messages. Please read enhanced mail facilities for more information.

Winpack's default is to have none of thes enhancements enabled. If you check the 'TPK compatibility 
mode' box, then all the enhancements are enabled.

If you check "Use Split Sessions" and your local BBS is FBB, WinPack will not attempt to use both 
compressed download and compressed forward on the same connect session. This option is needed 
because FBB V7 will not allow you to use both in the same session (FBB V5.15c does). If you don't use 
both compressed download and compressed forward, or    your local BBS is G1NNA, this option is 
ignored.
 
The "Human mode" option is a special case. Some BBSs are configured so that they won't allow a user 
to do anything that looks like BBS forwarding. This is most likely to occur with some USA types of BBS 
software, and with WinFBB, if the sysop has configured it in a particular way.

If you check "Human mode", WinPack will not send its SID banner (something like [WinPack-6.0-$]) to 
the BBS, and it will not attempt to add its own BID to messages when they are being forwarded. It will 
behave just as if you were running a manual connection. This should allow WinPack to be used with 
even the fussiest of BBSs (and the fussiest of BBS sysops!)

The normal choice of modes would be:-
1. If you have previously used TPK and your local FBB BBS sends the unproto beacons, select TPK 
compatibility mode.

2. If your local BBS is FBB but it doesn't send the beacons, or it sends the beacons but you turn your 
packet system off for long periods, select only compressed forward and compressed download. 

3. If your local BBS is NNA running V3 or later of the software, select compressed forward and 
compressed download. Please note that, when using compressed forwarding to an NNA BBS, FBB 
style compression is used, which is supported by the BBS.

4. If your local BBS is NNA running a version older than version 3, selected compressed forward.

5. If your local BBS is neither FBB nor NNA, select neither compressed forward nor compressed 
download.

6. Finally, if you find you still have trouble, select "Human mode".

Ask "Mail only this session?"
In some situations WinPack will prompt you "Mail only this session?" when you manually start an Auto 
BBS Session. If you say yes, bulls will not be downloaded on that session. WinPack won't always 
display this prompt because in some situations the question is not relevant. The prompt was originally 
put in at the request of several users, but several others have found it a nuisance. If you uncheck the 
box on the Mail Options form, WinPack will assume that you are always answering "No" and will not 
display the prompt.



Don't keep swapping!
It should be obvious from the above that there is an optimum way to use WinPack according to your 
specific situation. You can swap between compressed and non-compressed downloading and 
forwarding as much as you want. You can also swap between using and not using the unproto beacons 
as much as you want, BUT the setup changes that this causes mean the whole of your current 
message list WILL BE DELETED every time you change your usage of the unproto beacons. 

Also, you *MUST* make sure that there is no personal mail waiting to be downloaded or waiting to be 
sent to the BBS before you change your usage of the unproto beacons. If you don't you may lose some 
messages or find your system trying to download messages that don't exist.

You have been warned!



This option allows you to enable/disable the hints that appear when you pause the mouse over the 
buttons on the tool bar. You may find the hints useful or totally irritating!



This option gives access to a submenu that allows you to change some of the colours used in WinPack. 
You can change the background colour of the text windows and the colour of the LEDs.



Read a message on the BBS, at the top it will have a few lines that say, "To", "From", "Title", etc. or 
similar words. Put here the word that starts the date/time line. If there isn't one then put "Date/time".



Read a message on the BBS, at the top it will have a few lines that say, "To", "From", "Title", etc. or 
similar words. Put here the word that starts the message number line. If there isn't one then put 
"Message #".



WinPack Servers
WinPack supports servers. These are programs that can process an incoming message and send 
information to the sender of the message, without the WinPack sysop having to do anything.

A full discussion of how the servers work, is beyond the scope of this on-line help. However, the 
following explanation should help you understand them from the point of view of a user.

WinPack checks the title of every incoming personal message. If the title starts with a '/' then it checks 
to see if there is a program in its SERVERS directory with that name. For example, if the message title 
is "/REQCFG" then it looks for a program called REQCFG, if it exists then the program is started and 
allowed to process the message.

Three servers are supplied with WinPack, they are REQCFG, REQDIR and REQFIL. If you want to find 
out what they can do, send yourself a message via your local BBS entitled "/REQCFG" (without the 
quotes). The reply to that message will explain the use of the servers.

The file SERVERS.ZIP contains the Visual BASIC source code for one server. That should form a good 
base for anyone who wants to write WinPack servers.

Besides servers that respond to a special request, there are also servers that process all the incoming 
personal messages. These are placed in the SERVERS\RECEIVE directory. One server of this type is 
supplied with WinPack, it is ACK. It scans every personal message for lines starting with /QSL and, 
optionally, /ACK. If it finds one then it sends an acknowledgement message to the sender of the 
incoming message. It is configurable - see the file SERVERS\RECEIVE\ACK.INI.

There are also servers that process all outgoing mail. These are placed in the SERVERS\SEND 
directory. One server of this type is supplied with WinPack, it is BACKUP. It makes a backup copy of all 
your outgoing mail in the ARCHIVE\SEND subdirectory. So, if you don't want a backup of all your 
outgoing mail, you must delete the file SERVERS\SEND\BACKUP.EXE.

Finally, there are also servers that process all the incoming bulls. These are placed in the 
SERVERS\BULLS directory. No servers of this type are supplied with WinPack, but a server for 
checking PGP signatures in incoming bulls has been written and is available on request. However, it is 
useless unless you have the PGP program, which I cannot supply. You also need to understand the 
general principles of how PGP works.



PACKET.INI
Most of the setup information for WinPack is held in a file called PACKET.INI which is in the WINPACK 
directory. The majority of the entries in this file are changed by using the various WinPack menu 
options. However, there are some things which can only be changed by editing the file.

The file is divided into sections, each section has a header line "[TNC]". The following list shows all the 
entries that may be edited.

If you need to change any of the options listed below, exit from WinPack before you edit 
PACKET.INI. If you don't all your changes will be reset when the program is closed down!

Section [TERMINAL]
EXTERN_MINIMIZED - controls whether external programs and servers are run minimized, the default 
is FALSE.

EXTERN_FOCUS - controls whether external programs and servers are given the focus when they are 
run. The default is FALSE, but the default for versions of WinPack before 6.3 was TRUE. If you find a 
server or external program which worked with versions f WinPack before 6.3 gives problems with V6.3 
or later because it seems to get stuck, then put "EXTERN_FOCUS=TRUE".

FORMS_AT_TOP - if you put "FORMS_AT_TOP=TRUE" then the script and download windows will be 
positioned at the top of the screen, rather than in the middle. This leaves the editor window clear, so it is 
easier to use whilst an auto BBS session is taking place.

If you want program to minimize itself after a period of inactivity, change the line that says 
"MINIMIZE_TIME=0" to, for example, "MINIMIZE_TIME=10". That will cause the    program to minimize 
itself after 10 minutes with no input from you.

MODEM_IDLE_SECS - if you are using WinPack in "modem mode" with a telephone modem and there 
is no activity on the phone line for this number of seconds, WinPack will disconnect you. The default is 
60 seconds.

If you want the receive window to automatically pause when you scroll it instead of having to use the 
Pause button, change the line that says PAUSE_SECONDS=0 to, for example, 
PAUSE_SECONDS=10. This will enable a 10 second auto-pause every time you scroll the screen.

PERMANENT_YAPP_LOG - WinPack creates a log of all Yapp file transfers. By default the log is put in 
the MAIL\RECEIVE directory and appears as an 'X' status message in "Read Mail". The idea being that 
you will get a message whenever any Yapp transfers have taken place and you can read it and then 
delete it. If you don't want the Yapp log put in the mail directory, then put 
PERMANENT_YAPP_LOG=TRUE and the log will be put in the TEXT subdirectory.

PUB_DIR - this gives the path to the WinPack public files directory. The default is WINPACK\PUB, you 
can replace it with any valid DOS path.

RECONNECT_DELAY - sets the delay in seconds before a script will try to reconnect if a disconnection 
occurs, see scripts - how they work.

REPLY_QUOTE - right clicking on the "Reply To Sender" or "Reply To Topic" buttons whilst reading 
messages, will put you immediately into the edit window with any text you marked in the message 
quoted in the window. There will be a lead-in to the quoted text consisting of the sender's callsign and 
the words specified by REPLY_QUOTE. E.g:-

G4IDE wrote:-
> some quoted text



> some more quoted text
> etc.

If you put "REPLY_QUOTE=*" then there will be no lead-in text before the quoted text.

TIME_ZONE allows you to specify the name of the time zone to be displayed on the caption bar, and 
the offset of your PC's clock from that time zone. The format is "TIME_ZONE=AAA[nn]", where AAA is a 
3 character time zone name and [nn] is an optional correction to apply to your PC's local time. The 
default is "TIME_ZONE=UTC", that will put "UTC" on the caption bar and assumes that your PC clock 
is set to UTC, since no offset is specified. If your PC's clock is set to BST (one hour ahead of UTC), but 
you want WinPack to use UTC, then you would put "TIME_ZONE=UTC1".

WARN_BULL - I have seen many bulletins from WINPAC users that looked like the sender intended 
them to be an SP. They have always been replies to bulls. In fact I have seen so many that I have 
checked the code several times to see if the program could send a bull even if the user has clicked 
"Reply To Sender". My conclusion is that it is user error. From V5.56, if you click "Reply To Topic", 
WinPack asks you to verify that you really want to send a bulletin. You can disable this feature by 
putting "WARN_BULL=FALSE".

ZIP and UNZIP - if you want to use WinZip instead of PKZIP/PKUNZIP for zipping 7plus files and for 
unzipping 7plus zips for the viewers, you can put "ZIP=C:\WINZIP\WINZIP.EXE -min -a" and 
"UNZIP=C:\WINZIP\WINZIP.EXE -e -o -j". Obviously you put the correct path for your copy of WINZIP! 
Also, if you are using Win95, you will probably have got WINZIP32.EXE.

Section [LOG]
DATE_FORMAT - the default is "dd mm yy" which gives a date format in auto-log entries line "02 Nov 
95". Experience tells me that dates in that format are universally understood and unambiguous! 
However, I was once told that a popular logbook program could not import a log with the date in that 
format, so a useful alternative might be "dd/mm/yy".

LOG_FIELD1="A FIXED LOG FIELD" - you can put up to six fixed fields that will be appended to the 
end of each log entry (LOG_FIELD1 to LOG_FIELD6). You can put whatever text you want in the fields, 
and use as many of them as you want, you don't have to use any. This is to help with importing the 
WinPack log into logging programs that require some fields, e.g. RST, to be present.

USE_QUOTES - the auto-log entries are in comma separated values (CSV) format. All the fields are 
surrounded by quotes, which is correct. However, if you put "USE_QUOTES=FALSE" then the quotes 
will be omitted.

Section [FBB]
AUTO_KILL - the default is that WinPack will kill personal mail after it has been downloaded using FBB 
compressed mode. If you don't want your mail killed as soon as you have downloaded it, put 
"AUTO_KILL = FALSE". NB - this only applies to compressed download, if you are not using 
compressed download, then the mail will always be killed.

AUTO_RETRY - by default, if a message is unavailable on the BBS, WinPack will remove the selection 
'*' from it in your list and send you a message saying that is is unavailable. If you want it to leave the 
message marked, so WinPack will try to download it again on subsequent connects, put 
"AUTO_RETRY=TRUE".

BBS_UNPROTO    (default ">FBB") - when an FBB BBS sends the unproto message header beacons, 
it sends them to "FBB". A normal TNC will display the header line for the unproto broadcast as e.g. 
"GB7SKG>FBB". WinPack uses this header line to recognise the beacons. If you are using something 
other than a normal TNC, then you must change the BBS_UNPROTO entry to reflect whatever appears 
on your screen when the BBS sends a beacon. The normal reason for needing to change is if you are 



using TF or WA8DED firmware, because the header line will be e.g. "GB7SKG to FBB" - so you would 
need to put "BBS_UNPROTO=to FBB".

CHECK_LINK_STATE - if you are using the FBB unproto beacons, WinPack does an awful lot of 
checking to make sure that it doesn't send a sync request when it shouldn't, e.g. when it is connected ot 
another station. If you are convinced that sync requests are sneaking out when they shouldn't then 
putting an entry of "CHECK_LINK_STATE=TRUE" will cause WinPack to do even more checking 
before it sends a sync request. I will be surprised if this is ever necessary!

DOWNLOAD_RESUME - if FBB compressed download is used, then WinPack supports download 
resume. This means that if you are downloading a message and you get disconnected, WinPack will tell 
the BBS to start downloading again from where the interruption occurred, so the whole message 
doesn't have to be resent. This feature of FBB seems to be undocumented, it has been implemented by 
observing what TPK 1.82 does and by analysing the data that FBB sends when a download resume is 
requested. If WinPack finds the BBS is FBB 5.15, it will automatically enable download resume. You 
can over-ride this by setting DOWNLOAD_RESUME to TRUE or FALSE.

IM_A_SYSOP - normally WinPack will not put other people's personal messages in the bulls list, even 
though they are broadcast in the FBB unproto beacons. The reason is that there is no point putting 
them in the list because normally you can't read them. If you have sysop privileges, then you my wish to 
put "IM_A_SYSOP=TRUE", which will result in all the personal messages being put in the list.

MAX_SYNC_REPEATS - this is the number of times WinPack will send a resync to the BBS for the 
*same* message number before it gives up and sends you a System message. The default is 20. You 
can change it, but if you need to increase it, you shouldn't be using the unproto beacons, because your 
path to the BBS is too poor. (Unless you haven't got "HEADERLN ON" in your TNC settings!)

RESUME_ALLOWED - if your local FBB BBS indicates that it supports FBB forward resume (version 1 
protocol), then WinPack will use that protocol. If you want to stop it using forward resume for any 
reason, then put "RESUME_ALLOWED=FALSE".

SEND_FQ - the default of "SEND_FQ=TRUE" means that, after using FBB compressed forward, 
WinPack will disconnect from the BBS by sending "FQ" rather than by using a hard disconnect. If you 
want it to use a hard disconnect, you must put "SEND_FQ=FALSE". PLEASE NOTE - V6.1 and earlier 
defaulted to FALSE.
 

Section [BULLETINS]
By default WinPack removes the R: lines from messages. If you put "STRIP_R_LINES=FALSE" then it 
leaves them in.

If you leave WinPack on the read bulletins screen then it will time out after a default of 10 minutes of 
inactivity, or whatever other value is specified by TIME_OUT, and return to the main screen. If you put 
"TIME_OUT=0" then it will never time out.

If you are reading bulletins and you select the "To" button, WinPack will prompt you as to whether you 
want to create a list of all topics in the message base. If you will never want to create a list of topics put 
"TOPICS_LIST=FALSE". If you always want to create a list of topics and don't want to be prompted 
every time, put "TOPICS_LIST=TRUE".

Section [YAPP]
MAX_CPS sets the value for the end label on the data transfer bargraph on the file transfer status 
display. The default of 100 is a rough theoretical limit for 1200bps links running full duplex. You many 
prefer to put a lower value so that more of the graph is used. For 9600bps work the default is too low.

There are also a number of settings to do with Yapp file transfer that are described in yapp options.



Section [SHORTCUTS]
See using short cut keys.

Section [BPQ]
By default WinPack is BPQ application 1, which means it is the application that uses the BPQ 
BBSCALL and responds to the command BBS (or better, PMS) from the node. If you want it to have 
another application number, put, for example, "APPLICATION=4".

If you want to use the NODECALL for outgoing connections, put "USE_BBS_CALL=FALSE". If you 
want to change WinPack's BPQ application number, edit the "APPLICATION" entry.

Section [WINPTF]
INIT_ALL_CALLS - when used with TF firmware, WA8DED firmware, or PC Flexnet and TFEMU, 
WinPack initialises the callsign on channel 0 and channel 1 when it starts up to whatever callsign has 
been set in Personal/BBS Info. Unless you often change the callsign on the terminal channels to a 
completely different callsign, initialising channel 0 and channel 1 is quite adequate. If you do use 
different callsigns (note - different callsigns, not different SSIDs) on the terminal channels, then putting 
"INIT_ALL_CALLS=TRUE" will make sure that all the callsigns get reset to the the default callsign each 
time you start WinPack, but it makes WinPack take slightly longer to start up.

TFEMU_POLLRATE - if you use WinPack with PC Flexnet and TFEMU, WinPack constantly polls 
TFEMU for received data. The default is that it polls it 20 times a second. You can, if you wish, set a 
lower poll rate, but this variable was really put in for my own experimentation during development.

TFPCX_INT - if you use WinPack with PC Flexnet and TFEMU, WinPack expects TFEMU to be using 
DRSI style software interrupts. (I.e. TFEMU loaded with the command "TFEMU -dx"). If, for some 
reason, you wish to use TFEMU with TFPCX style software interrupts, then you must put 
"TFPCX_INT=TRUE".



Bulletin Topics (Advice)
When sending bulletins, you are much more likely to receive a reply if you send them to topics ("To" 
fields) that are in common use. A lot of people select the messages they read by topic (e.g. by using 
"L>" on FBB BBSs).
 
The topics list in WinPack is in BULLS\TOPICS.TXT. It is a subset of a list suggested by Brian, G8ASO. 
I have removed some that I thought were not used much in the UK and altered one or two others. Here 
are the topics it contains:-
 Topic Description
 144MHZ 2m news
 50MHZ 6m news
 70CM 70cm news
 9600 9600 baud operation help/info
 AERIAL Aerial topics
 AMIGA Amiga computer
 AMSAT AMSAT (satellite etc)
 AMSTRD Amstrad computer
 AMTOR Info about AMTOR
 APPLE Apple PC (see MAC for Mac's)
 ARCHIM Archimedes
 ASTRO Astronomical news
 ATARI ATARI Computer
 ATV Amat.Radio Television
 BARTG BARTG news & information
 BAYCOM Baycom H/W & S/W
 BBC BBC computer
 BBCTX BBS transmitter news
 BEACON Propagation Beacons information
 BIKE Motorbike topics
 BPQ Info about G8BPQ nodes
 CLOVER Clover
 COMMDR Commodore Computer (C128/C64)
 CONTES Contest news & information
 CQ Looking for packet contacts
 DCC DCC information
 DEBATE Debate - general topics
 DISABL Disabled
 DOS Disk operating software topics
 DX DX general information
 DXCC DXCC information
 DXNEWS Specific DX news bulletins
 FAX Fax information
 FBB Info about F6FBB software
 FOOD Recipies, etc
 FOOTY Football (for GBR only)
 GIF GIF files
 GP Graphic Packet help/info
 GPS Global Positioning System
 HELP General requests for info/help
 HUMOUR Jokes, amusing stories, etc.
 IBMPC IBM & compatible information
 ICOM ICOM gear
 INET Internet information
 INFO General information
 JNOS JNOS tcp/ip system



 JVFAX JVFAX information
 KENWOO Kenwood/Trio gear
 KEPLER Satellite Keplarian Elements
 KPC Kantronics gear
 LANDY Land Rover topics
 LINUX LINUX operating system
 LOTTER Lottery information
 MAC Macintosh
 MFJ MFJ gear
 MIR MIR topics
 MODEM Modem topics
 MODS Request or info, equipment mods
 MORSE Morse operating and comment
 MOTOR Motoring news - sport & leisure
 MSDOS Msdos info.
 MUSIC Music info.
 NASA NASA news & Information
 NEWS News bulletins
 NNA Information about G1NNA software
 NOS NOS tcp/ip system
 NOVICE Novice news and information
 OS2 OS/2 info.
 PACCOM PacComm gear
 PACKET Information about the packet net.
 PACTOR Pactor
 PAKET PAKET program info/help
 PENPAL Penpals info
 PMR PMR equipment mods, etc
 PROP Propagation topics
 QRP QRP topics
 RAE RAE notes and information
 RAFARS RAFARS
 RAIBC RAIBC topics & news
 RALLY Rally news
 RAYNET Raynet
 RIG Remote Imaging Group
 RIPOFF Ripoff comment!!
 RMG RSGB Repeater Management Group
 RNARS RNARS
 RSARS RSARS
 RSGB RSGB
 RTTY RTTY general information
 SAT All satellite information
 SATTV TV Satellites
 SCAN Scanner info
 SCHOOL School & Education topics
 SOLAR Solar data, Flare etc
 SPACE SpaceNews items, etc.
 SSTV Slow Scan TV info
 STATS Network & mailbox Statistics
 STOLEN Stolen Ham Gear reports
 SWL SW Broadcast news
 TCPIP TCP/IP topics
 TECH Technical Enquiries/Info
 TNC TNC information, general
 TPK TPK program help/info
 TREK StarTrek



 UFO U.F.O's
 UHF UHF .. all bands above 1000MHz
 UKIP UK IP information
 UNIX Info about UNIX systems
 UPAK UltraPak program help/info
 VHF VHF news amd information
 VIRUS Computer virus warnings/info
 WAB WAB info
 WIN31 Windows 3.1/3.11 help/info
 WIN95 Windows 95 help/info
 WINPAC WinPack program help/info
 WX Weather Information
 WXSAT Weather Satellite info (not Keps)
 YAESU Yaesu equipment info



Short Cut Keys
WinPack lets you set up frequently used strings of text so that you can key them in to the transmit 
window or the edit window with a single key stroke.

The keys that can be used to "hold" the text are Ctrl+F1 to Ctrl+F9.

To setup the text you must edit PACKET.INI and create entries in a section entitled [SHORTCUTS]. You 
will need to create the section, by default it doesn't exist.

Some example entries:-
F1=This is some text^M
F2=c gb7ide^Mll 10^Mb^M

The ^M is replaced with a <return>.
 
To send the text, you must make sure the cursor is in the transmit window or the edit window, then 
press Ctrl and the appropriate function key.



Topics List
The number next to each topic is the number of bulls in the message list for that topic. Select a topic 
from the list by either highlighting it and then pressing the "Select" button, or by double clicking it.

If you don't want the topics list to be available, you can disable it by editing the [BULLETINS] section of 
PACKET.INI.



This option is only available when you are composing mail or editing a message. If you select it then 
the message that you are writing is abandoned.



Message List Columns
Any program like WinPack that processes the 'raw' message list from a BBS has to know where the 
various columns of information are. I.e. where the "To" column is in the list, where the "From" column is, 
etc. Once you have got WinPack working and have collected your first message list from your local 
BBS, you should run the "Bulletin Columns" option on the "Options" menu. Use each item on this 
submenu in turn, and follow the prompts on the status line.

NB - if you are using the FBB unproto message beacons, the list columns are automatically set and the 
"Bulletin Columns" submenu is unavailable. The next bit is in large, red writing because, of all the 
avoidable "problems" that users have reported with WinPack, not setting    the bulletin columns is by far 
the most common!

 IF YOU AREN'T USING THE UNPROTO BEACONS AND YOU CHOOSE NOT TO BOTHER 
SETTING UP THE COLUMNS, THEN IT IS UNLIKELY THAT ANY OF THE AUTOMATIC MAIL 
FUNCTIONS WILL WORK PROPERLY. SELECTING BULLETINS USING "TO", "FROM", ETC, WILL 
NOT WORK AND THEMES WILL NOT WORK.



The Text Edit Menu
Cut    Ctrl+X
If you select this option, the currently highlighted text is cut and placed on the clipboard.

Copy    Ctrl+C
If you select this option, the currently highlighted text is copied to the clipboard.

Paste    Ctrl+V
This option is only available if the Edit window has the focus and there is text on the clipboard. 
Selecting it causes the text from the clipboard to be pasted into the window at the cursor position.

Paste & Quote    Ctrl+Q
This option is only available if the Edit window has the focus and there is text on the clipboard. 
Selecting it causes the text on the clipboard to be pasted into the window and then quoted as if you had 
pressed <F10> and selected "Quote" from the pop-up menu.

The idea of this option is to make it easy to quote text from a message to which you are replying. You 
mark the passage you want to quote, select "Copy", put the cursor in the Edit window and then select 
"Paste and Quote".



Dynamic Data Exchange
Dynamic Data Exchange (DDE) is a mechanism supported by the Windows operating system that 
enables two applications to "talk" to each other by automatically exchanging data.

From V5.2 onwards, WinPack supports DDE and can act as a DDE source.

To use the DDE facilities available in WinPack requires other programs to be written to take advantage 
of them. The file DDE.ZIP on the distribution disk contains a simple program which should provide 
sufficient information for any programmer who wishes to investigate the possibilities of writing programs 
to link to WinPack using DDE.

What might these programs do? Lots of things! Here are two ideas that have occurred to me:-

1. A program that would link to WinPack and monitor DX information from a DX cluster. As each "spot" 
was received, the program could automatically look up the DX callsign on a CD-ROM callbook, or 
perhaps operate a rotator to turn a beam in the required direction.

2. A packet checkers or chess game that used WinPack for the communications, so the game would 
not have to include all the code to link to the TNC, etc.



The BPQ Virtual TNC
There is a virtual TNC built in to the BPQ support code in WinPack. If you press <return> when not 
connected to another station you should get a "cmd:" prompt, just as if you were using a normal TNC. 
The virtual TNC only understands a few commands. It will accept abbreviations for the commands very 
much like a normal TNC, the minimum abbreviation for each command is shown in upper case. The 
supported commands are as follows:-

BText
The text that WinPack will pass to BPQ to send as beacon text. BPQ sends the beacon text as a UI 
frame at the interval specified by BTINTERVAL in BPQCFG.TXT. (Setting BTINTERVAL=0 disables the 
beacon text). The UI frame is sent to the address specifed by the UNPROTO entry in BPQCFG.TXT. 
BTEXT can include WinPack tokens, see the tokens list. The default BTEXT is "WinPack/BPQ".

NOTE - do not confuse the beacon text with the IDMSG which is set up in BPQCFG.TXT and sent at 
the interval specified by IDINTERVAL in BPQCFG.TXT.

Connect
Connect to the node.

Connect <callsign>
Connect you to another station. E.g. "C GB7OPC".

CText
The text that WinPack will send to a station that connects to your system. There are two CTEXTs, one 
used by WinPack and one used by the BPQ Terminal. The one used by WinPack can include WinPack 
tokens, see the tokens list, the one used by the Terminal cannot.

Display
Display the current settings for all the parameters.

MAsk
The list of ports on the node that will be monitored. The format of the command is, for example, "MASK 
1,2,3,4" if you want to monitor ports 1, 2, 3 and 4. If you are using the FBB beacons *always* have the 
port on which you hear the beacons included in the mask!

You can exclude all the ports by using the command "MASK 0".

NB!!    - Because of the way that BPQ works, the MASK command affects *all* Windows tasks using the 
node. Also, it is impossible to read from the node the current MASK setting, the value reported by 
WinPack is the last value it used for setting the MASK, it may not be the value currently in use!

If you alter the MASK setting for a Terminal session, you also alter it for WinPack. That is only a 
problem if you are using the FBB unproto beacons and you don't include the beacon port in the MASK, 
because WinPack won't then see any beacon transmissions.

MAXframe
The maximum number of frames that WinPack will allow to become queued waiting to be transmitted 
on its BPQ stream. When the queue is greater than this number it will buffer the frames internally. If you 
set MAXFRAME to a lower value than the MAXFRAME setting in BPQCFG.TXT, it will slow down your 
data transfer rate.

MCom



MCOM can be ON or OFF. It controls whether protocol control frames are monitored. NB - because of 
the way that BPQ works, the MCOM command affects *all* Windows tasks using the node.

MInbuffers
MINBUFFERS - sets the minimum number of buffers which must be available in the node for WinPack 
to queue any more transmitted frames. the default is 30.

Monitor
MONITOR can be ON or OFF. It controls whether monitored frames are displayed. Even with 
MONITOR OFF the frames are still processed for FBB beacons.

MTx
MTX can be ON or OFF. It controls whether frames transmitted by your node are monitored. NB - 
because of the way that BPQ works, the MTX command affects *all* Windows tasks using the node.

Paclen
The PACLEN used by WinPack when sending frames to the BPQ node. The default is 120.

Unproto
The unproto address for sending FBB sync requests. It defaults to the BBS callsign, which is usually 
correct. If you want to include digipeaters then put, for example, "GB7OPC,G8MZX,G4IDE" - G8MZX 
and G4IDE being the digipeaters.

UPort
The node port on which FBB unproto sync requests will be sent. It defaults to port 1.



WinPack and BPQ
WinPack can be used as a terminal "on top of" the G8BPQ node software. To use it you must have 
version 4.08a or later of the BPQ code.

To enable support for BPQ, you simply check the "Use BPQ" box on the comms setup screen. It should 
then work without any problems, provided, of course, that you have got BPQ running underneath 
Windows.

In BPQ mode a few things work differently. The split screen is used as a main window and a monitor 
window. The screen splits into a 1/3 and 2/3 ratio rather than splitting into two halves. (Don't forget that 
the ratio can always be changed by dragging the bar dividing the two sections).

If you are using the FBB beacons, they are monitored all the time, even while you are connected to the 
BBS.

WinPack has a built-in TNC in its BPQ support code, see BPQ Virtual TNC.

If you use WinPack with BPQ, you need to set up your system to send and receive mail slightly 
differently, see Mail Setup When Using BPQ.

Please note that BPQ can have a significant impact on Windows performance if the node is busy. You 
may find that the performance of your Windows programs becomes unacceptably slow.

Keeping Window 3.11 Happy!
It needs a bit of care to get BPQ working properly under Windows. If you have never used BPQ with 
DOS and you try and get BPQ, Windows and WinPack working all in one go, you've no chance!

One thing that often confuses people is that the BPQ code must be loaded before Windows is started - 
it *is not* run in a Windows DOS window. DOS tasks running in DOS windows can communicate with 
BPQ, but the BPQ code is loaded underneath Windows.

The approach should be:-
1. Get BPQ working with DOS so that you can make successful connections using PAC4. You don't 
need any TNCPORT entries in BPQCFG.TXT and you shouldn't load BPQHTNC2.

2. Read the BPQ information file WINBPQ.DOC and move BPQDLL.DLL and BPQCODE.386 to 
WINDOWS\SYSTEM.

3. Get Windows to run on top of BPQ, so that you can open a DOS window and run PAC4 with traffic 
being transmitted and received correctly, and Windows not misbehaving.

4. Still here? You've done the hard bit! WinPack should now work fine in BPQ mode.

One problem that can occur is that if BPQ is using COM ports and Windows "knows about" those ports, 
you're likely to have repeated system crashes. The reason is that BPQ will load interrupt handlers for 
the ports and then Windows will install its own interrupt handlers - a definite recipe for disaster! You can 
easily check to see if Windows knows about a COM port by running Windows Terminal and trying to 
assign the port in "Settings", "Communications".

My test system runs with BPQ and two ports, one is a KISS TNC on COM3, the other is an ethernet link 
to my BBS. I use Windows for Workgroups 3.11 and it is completely stable. I arranged my COM ports 
so that BPQ was using COM3 with an IRQ of 9. In SYSTEM.INI I have removed all references to COM3 
and put "COM3IRQ=-1" (minus one). That stops Windows trying to take over COM3. There are other 
ways of doing it, but I've found this method to be the best. 



Please don't even attempt to share IRQs between a COM port that BPQ is using and one that Windows 
is using. It won't work! That means if you assign a COM port to BPQ that is using, for example, IRQ4 
(INTLEVEL=4), you *cannot* have a Windows COM port that is also using IRQ4.

Keeping Win95 Happy!
If you are using Win95, it is easier to hide COM ports from Windows. You do it by setting up a hardware 
profile which does not include the ports that BPQ is using. It is very easy to set up two profiles - one 
which includes the ports for when BPQ is not being loaded and one that excludes the ports for when 
BPQ is loaded.

These profiles can be linked to MS-DOS multiple configurations, so you can have a 'BPQ' profile that 
excludes the ports and loads BPQ in AUTOEXEC.BAT before Win95 starts, and a 'normal' one that 
includes the ports and does not load BPQ.

See "Creating a hardware profile" in the Win95 help.

Again, please don't even attempt to share IRQs between a COM port that BPQ is using and one that 
Windows is using.

Changing WinPack's BPQ Application Number
PLEASE ignore this section unless you really understand BPQ!

By default, WinPack is BPQ application '1'. That means it will pick up incoming connects to the BPQ 
BBSCALL and respond to the "BBS" (best to change it to "PMS") command from the switch. You can 
change WinPack's application number by editing PACKET.INI so that it will respond to a different 
command from the switch.

For example, if you make it application number '4', and make your applications line in BPQCFG.TXT 
"APPLICATIONS=PMS,,SYSOP", then WinPack will respond to the "SYSOP" command from a user 
connected to the switch. If you make it application '5' (4+1) then it will respond to both "PMS" and 
"SYSOP".



This list box allows you to select a host mode. Normally you must select "None". If you are running BPQ 
node software underneath Windows, then you can use the "BPQ" option. On some versions of WinPack 
there will be no other options. However, some special versions will have options for specific host mode 
TNC firmware. In these cases full information on the available host mode(s) will be given under the 
"Host Mode Support" topic on the main menu.

NOTE - If WinPack is being used in "modem mode" - run with a command line option of "/modem" - this 
list box is disabled.



Mail Setup When Using BPQ
Callsign
Outgoing connections, when using BPQ, are made using BBSCALL as set up in BPQCFG.TXT. If you 
want to use NODECALL for outgoing connections, see PACKET.INI. For most people BBSCALL and 
NODECALL will be the same.

Unproto Beacons
If you are using the FBB unproto beacons, you must make sure that UNPROTO in the BPQ virtual TNC 
is set to the callsign of your local BBS, optionally with digipeaters in the path.

Unproto Port
If you are using the FBB unproto beacons, you must make sure that UPORT in the BPQ virtual TNC is 
set to the node port on which you hear the beacons.

BBS.TXT
When you are using BPQ, a connect occurs as soon as you connect to the switch. There if you send "C 
GB7OPC" you immediately get a connect, so there is no point using WAITCON in BBS.TXT.

The script must rely on WAITFOR, WAITLINE and WAITPROMPT to work out what is happening. A 
simple BBS.TXT is nothing more than:-

SEND C $BBS
WAITPROMPT



Command Line Options
From V5.5, WinPack supports a few command line options. They were all requested by users who had 
fairly specialised requirements. None of them are relevant to my use of the program and so I haven't 
really been able to test them.

You'll probably find it best to keep the normal WinPack icon and set up a new one with the required 
options.

To set command line options in Windows 3.1, highlight the icon, then select "File", "Properties" in 
Program Manager and add the required options to "Command Line", for example, "C:
\WINPACK\PACKET.EXE /NOCOM".

In Win95, if you haven't created a shortcut to WINPACK\PACKET.EXE then you should do so. You can 
then right click on the shortcut icon, select "Properties", "Shortcut" and add the options to "Target".

Modem Mode
If you add the option "/MODEM" to the WinPack command line, then WinPack will run in a mode 
designed for use with a telephone modem on the land-line port of an FBB BBS. If you want to 
sometimes use WinPack with a TNC and sometimes with a telephone modem, then I would suggest 
creating two icons for the the program - one with the "/MODEM" option and one without it.

For more information, see phone modem support.

Suppress the Splash Screen
"/NOSPLASH" will stop WinPack displaying a "splash screen" when it starts up. By default it displays 
SPLASH.BMP to give you something to look at while the program loads.

Automatic Prune
"/AUTOPRUNE" will cause WinPack to automatically prune the bulletin list when the program is started.
See Pruning The Bulletin List.

Options for use with Wisp
Three options were put in for a user who wanted to run the program alongside the Wisp satellite 
system. The idea was that GSC in Wisp would run WinPack in between    satellite passes. The 
/AUTOBBS and /NOCOM options are possibly of use in other situations.

"/AUTOBBS" - specifying this will cause an auto BBS session to start 30 seconds after WinPack is 
loaded. An optional delay can be specified, so "/AUTOBBS15" will result in the session starting 15 
minutes after the program is loaded.

"/AUTOEXIT" - the program will exit 1 minute after the first auto BBS session ends. Designed to be 
used in conjunction with "/AUTOBBS".

"/NOCOM" - WinPack will not attempt to use a COM port. It allows you to use the program just to read 
mail.

Multi-user Option "/USER="
"/USER=" is to help people who have more than one amateur in the family, or who use a club station, 
and want to be able to use the same WinPack system with different callsigns. The idea is to set up one 
Windows icon for each user, with a different "/USER=" on each command line.

My wife is also an amateur (G4GZL), so I could have two icons, one that had "/USER=G4IDE" on the 
command line, and one that had "/USER=G4GZL". WinPack would then maintain separate copies of 



PERSONAL.TXT, called G4IDE.TXT and G4GZL.TXT. (PERSONAL.TXT contains all the information on 
the "Personal/BBS Info" screen). It would also create separate mail send and receive subdirectories for 
G4IDE and G4GZL.

Because the user name is used as the file name, it must be 8 or less characters and only contain valid 
DOS file name characters. Your callsign is the obvious thing to use.

If STARTUP.TXT is used to set MYCALL in the TNC using the $MYCALL token ("SEND MYCALL 
$MYCALL"), this system can work fairly well. I have tested it by running G4IDE and G8MZX (the other 
callsign that I hold) from one system.

If you use the unproto beacons, WinPack scans the beacons for personal mail for all users, and 
maintains a separate list for each user of any mail waiting on the BBS.

Please take note of the following:-
Clear up any incoming or outgoing personal mail on your system before you start using multiple users. 
Otherwise you may lose it.

If you write mail but don't forward it, then it won't get uploaded to the BBS until *you* next use the 
WinPack system, simply because packet BBSs won't allow another callsign to forward mail from your 
callsign - it would infringe the "third party" regulations.

Similarly, mail will only be downloaded from the BBS for the callsign using WinPack at the time that the 
auto BBS connect occurs. You won't lose mail, but it can only be downloaded when *you* are using the 
system.

Set the Bulletins List command to "lr $num-". If you use "lr", messages will be listed more than once - 
everyone shares the same bulletin list in WinPack, but the BBS maintains a list pointer for each 
callsign. (This is irrelevant if you are using the FBB unproto beacons).



WinPack Extras
A quick "get you started" -

A newly installed WinPack system should show two "Extra" options on the File menu. These are 
"Selection List Editor" and "Start Alarms".

"Selection List Editor" provides an easy to use interface for editing the WinPack SELECT.TXT and 
AUTOTIME.TXT files. Once you start it, there is help available with <F1>.

"Start Alarms" allows you to start the Alarms program, which gives an audible warning when selected 
items of text are monitored by WinPack. Once you start it, there is help available with <F1>.

What Are "Extras"
"Extras" are programs that can be added to the WinPack File menu, but are not actually part of 
WinPack. Virtually any program can be used, but it obviously makes sense if it is in some way related to 
WinPack!

Each "extra" has a small file that is read each time WinPack is started. These files have an extension of 
.XTR, they must be in the main WINPACK directory. The format of a .XTR file is as follows:-

The file can contain from two to four lines. As the lines are read they are checked for any valid tokens 
from the tokens list. Any that are found are substituted. This is mainly of use for specifying a program 
path - see the comment below.

Line 1 is the caption for the File menu - if you don't want the "extra" to appear on the menu, leave this 
line blank.

Line 2 is the path name for the "extra" program. You can specify a full path, or a path relative to the 
main WinPack directory using the $WINP_PATH token. To do the latter, you must put a path such as:-

$WINP_PATH\THINGDIR\MYTHING.EXE

WinPack will automatically replace $WINP_PATH with its main directory path. If WinPack is in D:
\HAMRADIO\WINPACK then the above example would become:-

D:\HAMRADO\WINPACK\THINGDIR\MYTHING.EXE

Line 3 is either True or False according to whether you want the Extra to be automatically started when 
WinPack starts. The default is False.

Line 4 is either True or False according to whether you want the Extra to be terminated when WinPack 
is closed down. The default is False.

Example 1 - if you wanted to have Windows Notepad available from the WinPack file menu, go into the 
WINPACK directory and create a file called NOTEPAD.XTR. Put the following lines in the file:-
Windows Notepad
c:\windows\notepad.exe
False
False

Example 2 - if you find the Alarm program useful and would like it to automatically start whenever you 
run WinPack, edit the ALARM.XTR file and change the third line from "False", to "True"

Example 3 - an Extra for viewing the 7plus log file. Go into the WINPACK directory and create a file 
called VIEWLOG.XTR. Put in the following 4 lines:-



View 7plus Log
C:\WINDOWS\NOTEPAD.EXE $WINP_PATH\7PLUSLOG.TXT
False
False

This will allow you to view the log file using Notepad.

Note for Programmers
When an Extra is started from the File menu, WinPack does not attempt to change to the Extra's 
directory. Therefore the path for any work files should be derived from the EXE file's path. E.g. by using 
App.Path in Visual BASIC or by parsing argv[0] in 'C'. Do not make any assumption in your program 
about what directory it will be started from - it may not even be the main WINPACK directory.



The In Box (picture of a mail slot) and Out Box (picture of a post box) show if you have any new 
messages waiting to be read and if you have any messages waiting to be forwarded to the BBS. The 
numbers against the pictures show the number of messages in each box. If there aren't any messages 
waiting in either box, the images are not displayed.

Clicking on the In Box has then same effect as selecting "Mail", "Read Mail". Clicking on the Out Box is 
equivalent to selecting "Mail", "Edit a Message".

(In WinPack the boxes are displayed on the button bar, not as shown on this picture).



Registration
If you would like to register your copy of WinPack V6, please send a registration fee of 
10 ukp (UK pounds) to:-

Roger Barker, G4IDE
79 South Parade
Boston
Lincs PE21 7PN
UK

Please make sure you include your callsign, your name and your address. A suitable 
form is available for you to print off - click Registration form.

You will be sent by return post a registration number. If you prefer, the registration 
number can be sent to you via internet email, but it cannot be sent via packet. You 
should then use the "Register WinPack" option on the WinPack Help menu and input 
the registration information.

Once WinPack is registered, the "not registered" reminder box will stop appearing. It 
will also show your personal registration details when the program starts, and when 
"Registration Details" is selected from the Help menu.

Registering WinPack will help to ensure that development of the program 
continues. Many thanks for your support.



Registration Form

This form can be printed by using "Print Topic" from the "File" menu at the top of this help window.

To: Roger Barker, G4IDE
79 South Parade
Boston
Lincs PE21 7PN
UK

I would like to register my copy of WinPack V6. I enclose a registration fee of 10 
ukp (UK pounds). My registration information is as follows:-

Callsign    : _____________

Name          : __________________________________

Address : __________________________________

__________________________________

__________________________________

__________________________________

(Please write clearly. Callsign, name and at least two lines of address are 
required).



Selecting this option will zoom the edit    window up to the full size of the WinPack screen, selecting it 
again returns the window to its normal size. You can do the same thing by pressing Ctrl+Z.



Action Menu
Signature
Selecting this option will allow you to add a signature to a message you are writing. You will be 
presented with a list of available signature files and you can pick which one you want to use.

Note that if you use the signature button rather than this menu option, then the default signature is used 
- you won't be able to select your signature. (However, right clicking on the signature button gives a 
short cut to this menu option).

See also Signature Options.

Pause
Normally the receive windows will automatically scroll as new data is received so that the latest data is 
always visible. This can be a nuisance if you are trying to scroll back to view something that has gone 
off the screen, because as soon as some new data arrives the screen scrolls down again!

If you select this option then the automatic scrolling is disabled and so you are able to scroll back and 
view previous data. Don't leave pause on for too long, because while it is enabled all new data that is 
received is put into a buffer, which can only hold about 30,000 characters.

Selecting the option whilst pause is on turns it off.

This option has the same effect as pressing the Pause button. See also automatic pause facility.

Disconnect
Pressing this button should cause a disconnect (assuming you are connected to somebody!) It sends a 
Control_C and then 'd' to the TNC. It has the same effect as pressing the disconnect button.

Unproto Buffer
This option displays a form which shows any FBB unproto beacons that are currently being held in 
memory waiting for gaps in the list of received beacons to be filled. It gives an idea of how well, or how 
badly, you are receiving the beacons from your local BBS. Gaps occur when your system fails to hear 
beacons, with perfect reception of the beacons, the list will always be empty. The option is only 
available if you are using the FBB beacons.

Stay Connected
If you select this option *during an Auto BBS session*, when the session ends WinPack won't 
disconnect you from the BBS. However, please note that if the session uses compressed forwarding, 
this option will not be available.

Terminal
If you are using BPQ, this option starts the BPQ Terminal. If you are running another host mode then it 
will start a special terminal for that that host mode. Otherwise this option is not available.

Host Initialise
This option is only available if you are using a special host mode. If host mode communications with the 
TNC is lost for any reason, this option allows you to try to reinitialise it.

Host Reset
This option is only available with some special host modes. It carries out a complete reset of the host 
mode firmware, and then reinitialises it.



7plus Setup
See also Seven Plus (7+)

Auto 7plus Decode
If this option is checked then all personal mail and bulletins are scanned as they are received to see if 
they contain 7+ data. If they do then the data is extracted and put in the WINPACK\7DECODE directory.

When all the parts of a 7+ set have been received, the program will decode the file and send you a 
personal message as to whether the decode was successful or not. If it is successful then the parts are 
deleted. If it is unsuccessful then a .ERR file will be produced.

Scan Capture Files
If this option is checked WinPack will scan Capture files for 7plus parts. The scanning is done 
immediately after Capture is turned off. Any 7plus found will be identified in the log as coming from a 
capture file, apart from that the processing is exactly the same as for mail.

Keep 7plus Parts
If this option is checked, then, when a set of 7+ parts have been successfully decoded, the parts of the 
file are moved into the WINPACK\7PLUSOLD directory. If the option is not checked then the parts are 
simply deleted.

This option is only available if either "Auto 7plus Decode" or Scan Capture Files is checked.

Log 7plus Decode
If this option is checked, then, every time that WinPack attempts to decode a 7plus file, an entry will be 
made in the log file 7PLUSLOG.TXT. By looking at the log you can see when a file was decoded, if the 
decode was successful, whether it was received as a bulletin or as personal mail, and who sent it. 

This option is only available if "Auto 7plus Decode" or Scan Capture Files is checked.

7plus Part Size
This option allows you to set the maximum part size used for 7plus messages sent by WinPack. The 
default is 4000 bytes. Personally I think that is quite adequate and nothing is to be gained by using a 
larger part size, but I have had so many requests to make the size a user option that I've finally given 
in!

Don't forget that many BBSs in the UK quite correctly forward "smallest first", so if you use a very large 
part size, you will probably delay your own mail!



If you prune the bulletins list, or delete a block of lines from it, then normally any lines within the deleted 
section for which a bull has been downloaded and which have a status of    'Y' will not be deleted - to 
get rid of those lines you must first kill the bulletin.

If you enable "Block Delete Bulletins", these lines will be deleted and the associated bulletins will 
automatically be killed.

NB - you cannot delete bulletins with a status of 'N' in this way. WinPack will assume that, if you 
downloaded them, you want to read them.



What Is 7plus?
This section was written by Brian, G8ASO. I thank him for giving his permission to use it. It explains the 
basic theory of 7plus and why it is used. As far as WinPack is concerned, the only difference is that the 
tasks of encoding and decoding the 7plus parts, selecting a suitable part size and controlling the 
release of the parts to only a few per day, are automated.

Brian wrote an excellent series of notes intended to give help to packet users in understanding how the 
system works and answering some of the often asked questions. I thoroughly recommend them. For a 
current list of the files available send a REQuest FILe message:

                                                                  SP REQFIL @ G8ASO.GB7GLO.#46.GBR.EU
(Message Title)                START\HELP-NDX.ASO
(Message Text)                /EX

"What is this system that fills my screen with nonsense, and compels otherwise sensible people to 
deride each other?"

That is a quote from an enquiry recently. It could be compressed forwarding traffic between users of 
FBB, NNA, TPK or MSYS software. Or on some frequencies inter-node linking traffic. Or binary files 
being transferred.

For direct transfers of binary files, you can use YAPP. But for a mailbox to transfer binary files to remote 
users, it needs them to be formatted as messages of a suitable size. 7plus is a system that allows 
users to transfer binary files through the normal BBS system, without causing complete mayhem.

The problem with binary files, be they program files or compressed data files or picture files is that they 
contain characters that are used to define end of file, end of line, etc. which are used in normal mailbox 
operation. Also when sending data through the Packet Radio network, errors may occur in spite of the 
safety mechanisms incorporated into the AX25 protocol. Plain text with errors is still usually legible for 
humans. We can correct or ignore errors (as long as numbers aren't falsified) and thus still understand 
what it meant. Even at an error rate of 10%, we can still get the meaning of the text. On the other hand, 
the successful sending of a binary file requires that every byte is transferred without error.

How can this problem be overcome? The answer is to convert binary files to a format compatible with 
the BBSs. This task is done by ASCII-encoders like UUencode or more commonly now 7plus. 
UUencoding often doubled the size of the binary file. With 7plus it uses checksums on each and every 
line of code, and can recognize the exact position of errors and can process errors without having to 
resend entire files over and over again. UUencoded files can usually be sent in a network that only 
uses 7-bit codes.

The encoding scheme 7PLUS uses, could well be called a 7-three- quarter-bit encoding, because on 
the smallest scale, 31 bits of the original data are encoded into 32 bits (4 characters) of the 7PLUS 
code. That is one of the reasons, why 7PLUS is called 7PLUS. This causes an overhead of 1/32 = 
3.125%. Because of the required line delimiters, checksums, head and foot lines, the overhead 
increases to about 13% to 15%.

The characters used by the 7PLUS algorithm (in HEX notation) are 21 - 29, 2B - 7E, 80 - 90, 92, 94 - 
FC. Characters not used: 00 to 20 (Control codes and the space character) also 2A, 7F, 91 and 93.

To process 7plus files, either encode or decode you require the 7plus program, there are versions for 
IBM compatible machines, Atari, Amiga and Archimedes. Though obviously a program for one machine 
will not work on one of the others.

When preparing files for transmission, they should be compressed (the norm on PCs is to use PKZIP), 
if at all possible, to minimise the air time they will take. Then using 7PLUS the files should be split into 



sections, of perhaps 5k long maximum. You should not send too many files/sections during a day - 
other people want to use the channels after all. When you compressed files you can combine program 
and documentation in to one file. There is a recommendation of a maximum of 10 parts of 5k long being 
transferred on packet.

Items which are sent SHOULD NOT BE COPYRIGHT, unless it is your copyright, or where the 
copyright holder has given permission to allow distribution. As this is Amateur Radio, the files should 
reasonably be expected to have relevance to the hobby.

When you receive all the parts of a file distributed using 7plus it is simply re-constructed by running the 
program and telling it the name of the segmented files. If there are errors it will generate an error report, 
which would then be sent to the originator and a correction file generated. The program is run again 
with the original sections and the correction and it should all come together .... or generate another 
error file! If the original was sent as bulletins, watch out for corrections also sent as bulletins.



This option allows you to put the text from all the bulls in the current list selection into a file. Because it 
can create quite a large file, you will first be asked to confirm that this is what you really want to do. The 
button is only available when a selection has been made using "To", "From", etc. It replaces the 
"Unread" button.



Viewers
The concept of viewers is something new to AX25 packet radio. Please read the following carefully. If 
you don't understand what viewers do, you will find it very difficult to set them up!

What are Viewers?
Viewers allow you to "view" the contents of messages that contain other than plain text. They allow you 
to do it automatically without having to manually start another application.

"Viewing" means to look at the contents of a file. Normally, if you receive a 7plus file which contains, 
say, a zipped JPG image,    to look at the image you must first unzip the file, then you must run another 
program to actually look at the image. If you have configured a viewer for JPG files in Winpack, then, 
when you read the SYSTEM message telling you that the file has been received, you will be offered the 
opportunity of viewing it - you won't need to unzip it and the viewer application will be started by 
WinPack.

Viewers can be configured for any file type for which you have a suitable program available, not just for 
image files. For example, you can set up viewers for WAV files, MIDI files or HTML files.

Viewers    work in two ways:-

1. They allow an incoming non-7plus SB or SP to be viewed by an external application.

2. They allow the contents of decoded 7plus files to be viewed by an external application.

Viewing non-7plus SBs and SPs
This requires the sender of the message to include information about its contents in the title, therefore it 
requires something which currently does not happen! Hopefully it will, once this feature of WinPack is in 
general use. Because SBs and SPs are plain text, there isn't much you can put in them that benefits 
from being viewed with an external program, except for HTML - which is plain text! Here's an example 
of how it works:-

I send an SB to WINPAC at GBR entitled "Something from Roger ^.htm". Someone using the new 
version of WinPack reads it and his system recognises the "^.htm" as being an indicator of file type. His 
system checks to see if he has a viewer configured for files with the extension ".HTM", if he has, then 
WinPack asks if he wants to view the file using the external program. You therefore have a facility for 
sending and receiving messages which can be made far more readable than if they are viewed as 
boring plain text. (To send HTML you do, of course, need an HTML editor!)

Viewing decoded 7plus files
When WinPack successfully decodes a 7plus file, it sends you a SYSTEM message. When you read 
that message, WinPack will check to see if you have a viewer configured for the file type, if you have, 
then it will ask you if you want to view the decoded file. A lot of 7plus is, of course, zipped up. If 
WinPack finds a zip it will look in it and see if there is a viewable file. One restriction is that you can only 
view one file in each zip - otherwise it would become unmanageable. However, the vast majority of 
7plus zips only contain one file. The file offered for viewing is the first one in the zip for which a viewer 
is configured. This has implications for viewing HTML - see "A Few Comments" below.

Configuring viewers
To be able to view files, you need to tell WinPack what viewers to use for each file type. This is done by 
creating a section in PACKET.INI called [VIEWERS] and putting in it the information about the programs 
you wish to use as viewers.

The format of each line is "<file type extension>=<path to viewer>". There is one important exception:-



If a WWW browser is used as a viewer, it can take an awful long time to load. Netscape allows you to 
pass files to the program whilst it is running by using a DDE link, so avoiding having to keep reloading 
it. Internet Explorer *V3* is compatible with this feature of Netscape. If you use a browser that is 
compatible, you can put "NDDE" at the end of its line, to tell WinPack to use Netscape style DDE. 
Please note - my own tests suggest that Internet Explorer V2 is not compatible. If you want to take 
advantage of DDE, *don't* close your browser after you have viewed a file, minimise it instead.

A WinPack "extra" is provided to make configuring viewers easier, it appears on the WinPack "File" 
menu as "Viewers Editor". When you run it, press F1 and read the help.

My viewers under Windows 3.11:-

[VIEWERS]
htm=c:\netscape\netscape.exe
wav=c:\windows\recorder.exe
mid=c:\windows\mplayer.exe
bmp=c:\windows\pbrush.exe
pcx=c:\windows\pbrush.exe
jpg=c:\netscape\netscape.exe
gif=c:\netscape\netscape.exe
txt=c:\windows\notepad.exe
doc=c:\winword\winword.exe

My viewers under Windows 95:-

[VIEWERS]
htm=c:\progra~1\micros~2\iexplore.exe ndde
wav=c:\windows\sndrec32.exe
mid=c:\windows\mplayer.exe
bmp=c:\progra~1\access~1\mspaint.exe
pcx=c:\progra~1\access~1\mspaint.exe
jpg=c:\progra~1\micros~2\iexplore.exe ndde
gif=c:\progra~1\micros~2\iexplore.exe ndde
txt=c:\progra~1\access~1\wordpad.exe
doc=c:\progra~1\access~1\wordpad.exe

Note - the directory names have to be the short, DOS compatible names.

The SPK Viewer
If you set up a viewer for SPK files, then this viewer has a special function. It is intended that a SPK 
viewer should be intended for speaking messages. (A sample SPK viewer which works with the 
SoundBlaster TextOle utility is supplied with WinPack). Not only will the SPK viewer work with 
messages with ^.SPK in the title, it will also work with any message. If you press Ctrl+T ('T' for talk) 
whilst reading a message, then the SPK viewer will be called.

Configuring PKUNZIP.PIF
To be able to unzip 7plus files and allow you to view the contents, WinPack has to be able to run 
PKUNZIP.EXE and it does this by using PKUNZIP.PIF. The default PIF I have supplied assumes that 
PKUNZIP.EXE is in a directory on your path. if it isn't, you need to edit the PIF and change the Program 
Filename, making sure you include the full path to the file, e.g. C:\PK\PKUNZIP.EXE. In Windows 3.11 
use the PIF Editor. In Windows 95 you find the WINPACK\PKUNZIP.PIF program icon in My Computer, 
or by one of the several other methods available, then right click on it and change "Properties", 
"Program", "Cmd line".



Please check the above carefully - an awful lot of people seem to have had problems setting up the 
PKZIP.PIF supplied with WinPack!

I have only tested it with PKUNZIP 2.04g. I've no idea if it works with earlier versions or with other 
unzippers.

Enabling "Use Viewers"
Make sure that "Options", "Use Viewers" is checked. It *should* now all work!

Complex HTML
If you want to send an HTML document containing images or sound, then you should be careful as to 
the order in which you zip the files. The main HTML document should be the first file in the zip, so that 
will be the file which    WinPack offers for viewing. If you do this, then provided that all references to 
other documents, images, etc, are local to the main document, you should find that it can all be viewed 
successfully. On the other hand, if you build the zip and put, say, a GIF image as the first file, then 
WinPack will offer that file for viewing, not the HTML file.



See Viewers



FBB Unproto Buffer
This window shows all the FBB message header beacons being held in memory, waiting for gaps in the 
message list to be filled.

Each line is the text of a message header, preceded by a second copy of the message number. This 
second copy is always padded with '0's to 6 digits in length and enables WinPack to easily sort the 
headers into numerical order. (The message number in the header is left justified and so will not always 
sort into the correct order).



Registration Information
If you have registered WinPack, then selecting "Registration Details" from the Help menu displays your 
registration information, otherwise it displays a window saying that the program is not registered.

If your registration information is displayed, there is a check box which is labelled "Show At Start Up" - 
the default is that WinPack briefly displays your registration information every time the program is 
started. If you don't want it to do that, then uncheck this box. PLEASE NOTE - you CANNOT uncheck 
the box if the callsign in the registration information is not the same as the callsign set in "Personal/BBS 
Info". 



Phone Modem Support
If you add the option "/MODEM" to the WinPack command line, then WinPack will run in a mode 
designed for use with a telephone modem on the land-line port of an FBB BBS. If you want to 
sometimes use WinPack with a TNC and sometimes with a telephone modem, then I would suggest 
creating two icons for the the program - one with the "/MODEM" option and one without it.

In modem mode the caption bar will include the text "(Modem)" and several things internal to the 
program will work differently. Do not try to use either compressed forward or compressed download in 
modem mode, and, of course, you can't use the FBB beacons!

To the best of my knowledge, an FBB BBS, when used via the modem port,normally requires a 
password. Here is a sample BBS.TXT file for modem use    - THE PHONE NUMBER IS FICTITIOUS, 
don't try and use it!

HOTKEY F2
TITLE Connect to the local BBS
;Send some modem initialisation stuff if needed.
;Probably best to at least send an ATZ, so you
;get the OK back and you then know the modem
;is responding.
send AT&F&D3&R0\V4S7=40
waitline OK
;Dial the number.
send ATDT01205654321
;Wait for the login prompt.
waitfor Callsign :
send G8MZX
waitfor Password :
send QKVRTX
;Wait for the BBS prompt. I found that it was
;better to put in the actual text than to use
;the WinPack WAITPROMPT option. I'm not sure why,
;and, after many phone calls trying to find out
;why, I gave up on it!
waitfor GB7OAR Next Roger



This button allows you to select a theme from a list of the bulletin themes that are available on your 
Winpack    system. For more information on themes, see What Are Themes? A maximum of 350 
messages can be displayed in the list when you use a theme.



What Are Themes?
When you are reading bulletins in WinPack, you have filter buttons available which allow you to select 
all the bulls to a certain topic, all the bulls from a particular sender, etc.

Because of the way that people address messages, you often find that two or more different topic 
addresses will be used for the same subject and people send bulletins to ALL, or HELP about pretty 
much anything.

By creating a theme you can link several selection criteria together, so, when you select that theme 
when reading bulletins in WinPack, all messages meeting the selection criteria for the theme are 
displayed.

For example, you might create a theme called "WinPack", which contains the following selections.

[TO]
WINPAC
WINPAK
WINP7

[TITLE TEXT]
WINPACK

[FROM]
G4IDE

You can create and edit themes using the "Themes Editor" option on the File menu.



This buttons allows you to filter the displayed message list by "at" address. A maximum of 350 
messages can be displayed in the list when you use this filter.



Logging
Auto Log
If this option is checked then WinPack will log all connections and disconnections in a file called 
TEXT\AUTOLOG.TXT. I'm not sure if this log is sufficent to replace a 'proper' log. Any comments on this 
will be appreciated.

Auto Dump
This option allows you to enable or disable the 'auto-dump' facility. When auto-dump is enabled, then, 
whilst you are connected to another station, all transmitted and received text is saved in the file 
TEXT\AUTODUMP.TXT.

If you have auto-dump enabled, then be warned that, if you are very active on packet, AUTODUMP.TXT 
can get very large very quickly! Every time you enable this option, WinPack checks to see if 
AUTODUMP.TXT already exists, if it does then you are given the option of overwriting the existing file 
or appending to it. So, if you want to clear the file and start again, simply disable and then re-enable the 
option.

Log Frequency/Power
This option allows you to select a different frequency and power to be used in the auto-log. When 
WinPack starts up, the default is always to use the frequency and power as specified in your personal 
information and those values are automatically added as the first item on the "Log Frequency/Power" 
sub-menu.

If you want other frequency/power options to be available, you must create a file in the WINPACK 
directory called LOGFREQ.TXT and put some settings in it. Here is an example of the required format 
for the data in this file:-

144.650MHz/10dBW
144.675MHz/10dBw
432.675MHz/13dBW

When you select an option on the menu, that frequency and power will be used in log entries, but 
WinPack will always return to the default values when the program is restarted.



Creating And Using Mailing Lists
If you regularly want to send the same message to several recipients, then you may find it helpful to 
create a Mailing List.

Mailing Lists live in the MAIL\LISTS subdirectory. Each list contains the packet addresses of the 
recipients for messages sent to that list. It can also contain comment lines - these must start with ';'. You 
should create a list with a plain text editor - either the WinPack editor or NotePad is recommended.

The file name of a list must obey the following rules - it must be a valid DOS file name, with an 
extension of ".TXT" and the first part of the name cannot have more than five characters. Therefore 
CLUB.TXT or LOCAL.TXT would be valid list names, but MYCLUB.TXT would not be (too long).

Here is an example of a list which I called TEST.TXT:-
;This is my list for testing WinPack.
G0OPC @ GB7WNM
G8MZX @ GB7SKG
G4IDE @ GB7OAR.#16.GBR.EU

To send a message to the members of a list, you put the list name preceded by an exclamation mark in 
the "To" field of the "Write A Message" header form. With my example list, I would sent the message to 
"!TEST". WinPack will check if the list exists and it won't allow you to proceed if it doesn't.

When you connect to your local BBS and upload mail, WinPack copies the message to each recipient 
in the list and deletes the original. Please note that this is not as efficient as using a carbon server on 
the BBS, because you have to upload the message once for each recipient, whereas if you use a 
carbon server you only upload it once.

If you get disconnected from the BBS during the forwarding session, you will find that the unsent 
individual messages will be in your WinPack outbox, not the original message, but these can be 
forwarded on the next connect.



If this option is enabled, then the keyboard Scroll Lock key LED will flash if you have unread mail in 
your mail box.

Please note that direct manipulation of the keyboard state in this way by a Windows application is not 
really good programming practice. If you find that the flashing Scroll Lock gives you problems with other 
applications that you    run at the same time as WinPack, then the only solution is to disable this option.



7plus...

The use of Seven Plus to send binary files is one of the most controversial subjects on the UK packet 
network. It is controversial because Seven Plus is so often used incorrectly by people sending very 
large files, or sending parts that are far too large. Before you use Seven Plus you should familiarise 
yourself with the DCC document "Guidelines For The Use Of The Packet Radio Network". A copy of this 
document is include with WinPack and can be viewed by clicking the "Guidelines" icon in the WinPack 
Program group. If you would like to read it now, select The DCC Guidelines.

The two topics below contain general information on using 7plus, and details of how to use the 7plus 
facilities in WinPack.

What Is 7plus?
7plus Send/Receive



Pruning The Bulletin List
There are several ways to prune the WinPack bulletin list.

The simplest way is to view the list using "Read Bulletins" and use the "Delete" and "Prune" buttons at 
the bottom of the list.

For information on using the "Delete" button, see Deleting Bulletins from the list.

For information on using the "Prune" button, see Pruning Bulletins from the list.

WinPack is also able to prune the list automatically, either when the program is started or at user-
defined times. An automatic prune will behave as if you have used the "Prune" button while reading 
bulletins, without having marked a block - see the above link for more information. PLEASE NOTE that, 
as explained in the link, your settings of "Block Delete Bulletins" and "Bulletin List Prune Size" will affect 
what happens. See Bulletin Deleting options for more information on what these two options do.

To prune the list when the program is started, add a command line option of "/AUTOPRUNE" - see 
Command Line Options for more information on how to do this. 

To prune the list at user-defined times, use "File", "Selection List Editor" and add some times to the 
"Auto Times" list with "PRUNE" as a suffix. For example "12:30 PRUNE", "22:45 PRUNE". An automatic 
prune will be run at those times each day (assuming that WinPack is running).






